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1 Introduction

1.1 Overview
Plan of the course

Aim: Enable people to use OpenFOAM effectively and independently

e Will utilise the power of GNU/Linux (UNIX), using shell commands,
e.g.
>> echo "Welcome to OpenFOAM"
Welcome to OpenFOAM

e Will view/edit code and case files, displayed with line numbers, e.g.

1 GNU GENERAL PUBLIC LICENSE
2 Version 2, June 1991

e Everything is demonstrated with cases users can follow on their machines

e Emphasis on how to explore OpenFOAM
What is OpenFOAM?

e Software for computational fluid dynamics (CFD) (and other continuum

mechanics). . .
e ...designed as a programmable toolbox. ..
e ... for simulation of real, 3-dimensional problems in science/engineering

Freely available and open source, licensed under the GNU General Public
Licence

Produced by OpenCFD Ltd
A toolbox, not a black box

e Supplied with source code and compilers
e Customised applications can be created for specific problems. . .

e ...using functionality built into generic modules (libraries)

OpenVFOAM-1.7.1

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011




Introduction

e Top level code represents the equations being solved, e.g,

opU
%+VopUU~V-pR: —-Vp
?olve

fvm: :ddt (rho, U)

+ fvm::div(phi, U)
+ turbulence->divRhoR (U)

S S I XN I

o

fvc::grad(p)

®

What is in a typical CFD software package?

e 1 (or a few) software executable(s)
e Example case files
e Documentation

e Data and configuration files
What is in the OpenFOAM distribution?

e 200+ executable applications, not a single executable
e Example case files

e Documentation

e Data and configuration files

e Source code files

e Shared-object libraries

e Compilation scripts

e Other scripts

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011

OpenVFOAM-1.7.1

A

1}

194993939393333939388888%% ey

1.1 Overview

OpenFOAM is different

e The source code is a key source of information itself

e It can be modified and recompiled

e Can be frequently extended and upgraded

= Users benefit from being familiar with the OpenFOAM distribution

Installation

e At present there are 2 OpenFOAM distributions:

Ubuntu/Debian installation of binaries and sources using the apt
package manager; easy to install.

General Linux distribution supplied as source code including third
party software, requires compilation; more difficult to install.

e See the latest information:

— http://www.openfoam.com/download: Installation overview

— http://www.openfoam.com/download/ubuntu. php: Ubuntu instal-

lation information

— http://www.openfoam.com/download/source.php: Source instal-
lation information

What is in the OpenFOAM distribution?

<installDir>
L <packageDir>

L src
- applications
L1ib
L wmake
L bin
L tutorials
L doc
Letc

Installation directory

OpenFOAM package directory
Source code files

Application sources and executables
Shared-object libraries

Compilation scripts

Other scripts

Example case files

Documentation

Data and configuration files

e <installDir> can be $HOME/OpenF0AM, /opt, ...

e <packageDir> can be OpenFOAM-1.7.1 or openfoam171

(©2008-2011 OpenCFD Ltd
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Navigating the OpenFOAM distribution

e Environment variables are pre-defined for important OpenFOAM direc-
tories, e.g. $WM_PROJECT_DIR, in files in etc

e Quick changes of directory pre-defined using aliases, e.g. alias foam=’cd

$WM_PROJECT_DIR’

Directory Description Env. variable Alias
<packageDir> Installation dir. $WM_PROJECT_DIR foam
L src Source files $FOAM_SRC src
L OpenFOAM Main library source foamsrc
L finiteVolume finiteVolume library foamfv
L applications Applications source  $FOAM_APP app
L solvers Solver apps $FOAM_SOLVERS sol
Lutilities Utility apps $FOAM_UTILITIES util
L tutorials Example cases $FOAM_TUTORIALS tut

OpenFOAM user directory

OpenFOAM expects a user directory to exist in the ~/0penFOAM direc-
tory (* = home dir)

Named ${LOGNAME}-1.7.1 — i.e. ubuntu-1.7.1 for user ‘ubuntu’
Environment variable $WM_PROJECT_USER_DIR set to the user directory
Version numbered user directories provides convenient version control

Can mirror the installation directory, e.g. solvers located in:

/opt/openfoam171/applications/solvers in the installation
~/OpenFOAM/ubuntul.7.1/applications/solvers in the user’s files

Case files are stored in a run subdirectory
— ~/0penFO0AM/ubuntul.7.1/run

— env. variable: $FOAM_RUN

— pre-defined alias to change directory: run

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenVFOAM-l-Tl
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1.2 Applications
Applications

e OpenFOAM is distributed with ~200 applications, in applications
directory

e Split into solvers and utilities subdirectories, where
solvers simulate specific problems in CFD and other engineering mechanics

utilities perform pre- and post-processing tasks data manipulations, visual-
isation, mesh processing, ...

e The solvers and utilities directories are organised into subdirecto-
ries whose names represent types of flow, utility, ...

e For a given application, e.g. icoFoam

— The source code is in a directory named icoFoam
see $FOAM_SOLVERS/incompressible/icoFoam

— The main .C source file is named icoFoam.C

— The executable is named icoFoam

e The header of the main .C file has a description of the application’s use,

e.g.
Description
Transient solver for incompressible, laminar flow of Newtonian fluids.
(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenVFOAM-l.u
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» Flow between parallel plates

2 Flow between parallel plates Setting up a case in OpenFOAM

icoFoam — e Choose solver

2.1 Overview and case files L cavity — e Copy example case for that solver

Flow between parallel plates
L constant

{ e Create/modify mesh

e Select models and properties

300 mm /\/

Lo e Initialise fields & BCs for p, U, etc.

Y

4)
L system — e Set case controls, e.g. At, schemes, tolerances

h = 10 mm

Solver and case

e Solver: icoFoam and pisoFoam are both suitable

— from the $FOAM_SOLVERS/incompressible directory

— Description in .C file fits the requirements

e Transient solution . . .
e Let’s use icoFoam — a stripped down solver we can examine later

s d5i — 10-4m2 /2 Re —
* Laminar, v =107 m"/#", Re =400 e Create a new case called parallelPlate from existing icoFoam case

s Tssthermal called cavity — in $FOAM_TUTORIALS/incompressible/icoFoam

e Incompressible e Make a local copy of the cavity case, renaming it parallelPlate
L] I)]u 4 ﬂO / il l t U =1 /s >> run
S >> cp -r $FOAM_TUTORIALS/incompressible/icoFoam/cavity parallelPlate

U. — — (h? — y?) e Change to the parallelPlate case directory
X 21/ U
3v >> cd parallelPlate
(Vp)e = —33Q

. _ Case files

where ) =volumetric flow rate / unit area

e In OpenFOAM case data is stored in a set of files within a case directory,
not in a single case file

e The case directory can be given any name, e.g. cavity for cavity
flow

©2008-2011 OpenCFD Ltd /1.7.1 rev 7. 3/5/2011 OpeﬂVFOAM-l-Tl (©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenVFOAM-U.l
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12 Flow between parallel plates
<case>, e.g. cavity Case directory

L system Dictionaries of solution parameters
L controlDict Time and data input /output control
L fvSchemes Numerical schemes
L fvSolution Linear-solver parameters, e.g. tolerances

L constant Constant (unchanging) data
L polyMesh Mesh
L ...Properties Physical properties, e.g. transportProperties

L Time directories Time-varying data, directories named after simulated

time, e.g. 0, 0.1, 0.2, ...

2.2 Meshing

Mesh generation using blockMesh

e blockMesh is a simple mesh generator using blocks
e Allows multiple blocks and curved edges

e Configured by a blockMeshDict file in the constant/polyMesh direc-
tory of a case

e Produces a 3D mesh of hexahedral cells

e OpenFOAM always uses 3D meshes, handling 1D, 2D and axisymmetric
cases using special boundary conditions

e There are lot of examples in the tutorials — copy something suitable for
your needs and modify it

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OPBHVFOAM'1'7'1
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2.2  Meshing 13

blockMeshDict configuration: vertices

S ————— 12
E.\ ...... |“\.\l
. 7 :. 6

e
N

L] e e e e 5 e L
\4 N 5

e A list of vertices is specified
e All values are scaled by convertToMeters
e [dit these in the blockMeshDict file

e For convenience: z-depth = 0.1xy-height

17 convertToMeters 0.01;

19 zertices

21 (0 -1 -0.1)
22 (30 -1 -0.1)
23 (30 1 -0.1)
24 (0 1 -0.1)
2 (0 -1 0.1)
26 (30 -1 0.1)
27 (30 1 0.1)
28 y (O 1 0.1)
29 H

blockMeshDict configuration: blocks

31 blocks

32 ¢

33 hex (0 1 2345 67) // vertex list

34 (300 20 1) // no. cells in each dir.
35 simpleGrading (1 1 1) // cell expansion ratios
36 X

e Block description begins with hex followed by list of vertices
e Order of vertices is critical

e The 1Ist 4 vertices describe one plane; the 2nd 4 describe another plane

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenVFOAM-l.m




14 Flow between parallel plates

e The order defines a local coordinate system (z1, z,, 23)

plane 1 plane 2 2

| || |
hex (01 234567) ?1‘2
2 bl [ eetlgie ]
Ty
e J :L?*
x3 < 4

e The resulting (z1,z2,23) local coordinate system must be right-handed

T

— looking down the Oxg axis — with O nearest — an arc from the
Ox; axis to the Oz axis is in a clockwise sense.

e cg, (5647610 3 2) would also work; but (1 0 3 25 4 7 6)

would produce a left-handed block
blockMeshDict configuration: blocks (2)

e (300 20 1) gives the number of cells in each direction of the block’s

local coordinate system
— Here, only 1 is needed in the z-direction because the case is 2D
e The final entries specify cell grading
e Hither simpleGrading or edgeGrading

— simpleGrading: requires 3 expansion ratios
— edgeGrading: requires 12 expansion ratios — see User Guide for
details
e Expansion ratios are ratios of cell lengths from end to start cell; grading
is linear in between

Expansion ratio = —
(55 pans at - O. (Sc

— e "

Expansion direction

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenVFOAM»l.Tl
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2.2 Meshing 15

blockMeshDict configuration: patches

40 patches

41 (

42 patch inlet
43 (

A5

46 patch outlet
a7 (

48 (2651)
49

50 zall walls

51

52 (376 2)
53 ; (1540)
54

55 empty frontAndBack
56 (

57 (0321)
58 (4567)
50 b

60 )

e Patch defined by “<type> <name> <faceList>"

e <type> = patch is the default type

e <type> = empty for 2D front and back planes
e <type> = wall for walls (or patch, if no turbulence modelling)
e <name>: used to identify the patch
e <faceList>: set of faces, each defined by 4 vertex points in order along
a path around the face edges
Running blockMesh
e In a terminal type the utility name with the -help option — to display
usage
>> blockMesh -help

Usage: blockMesh [-region region name] [-case dir] [-blockTopologyl [-help]
[-doc] [-srcDoc]

e Requires no arguments if executed from within the case directory
e Otherwise use -case <caseDir> to specify the case directory

e = to run blockMesh on the parallelPlate case

(©2008-2011 OpenCFD Ltd V1.7.1 rev 7. 3/5/2011 OpenVFOAM-1.7.1
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2.2 Meshing 17

16 Flow between p

arallel plates

>> cd $FOAM_RUN/parallelPlate — If a boundary face, neighbour index = -1

>> blockMesh

constant
e That generates the mesh, written to a set of files in constant/polyMesh L polyMesh Mesh
L points List of points (vectors)
Meshes in OpenFOAM L faces List of faces, each face being a list of indices to points
L owner List of face owner-cell labels, the index = face index
e OpenFOAM operates in a 3 dimensional Cartesian coordinate system - neighbour List of face neighbour-cell labels, the index = face index
L boundary List of patches, each a dictionary, declared by name

— 1- and 2- dimensional and axi-symmetric simulated on 3-D meshes

by applying special boundary conditions
The faces list

e Arbitrary polyhedral cells in 3-D, bounded by arbitrary polygonal faces faces
— A cell can have an unlimited number of faces face 0
— A face has an unlimited number of edges face 1
— No restriction on face alignment
— Internal faces intersect two cells only
’ Internal faces
— Boundary faces belong to one cell
o Offers great freedom in mesh generation and manipulation
e Known as polyMesh in OpenFOAM
The polyMesh description Patch 0
Patch 1
Boundary faces
startFace —f» |
D )
nFaces Patch 2

The list of faces is ordered in OpenFOAM

Internal faces appear first

Boundary faces then appear, ordered according to patches

e Face-based description

Each patch described by startFace and nFaces
e Each face is assigned an owner (P) and neighbour (N) cell

OpenVFOAM-1.7.1 ©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/6/2011 OpenVFOAM-1.7.1
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Flow between p

The boundary file

e The boundary file can be viewed and edited

e Users can modify patch names and types

19 4
20 (
21 inlet //
22 {
23 type patch; //
24 nFaces 20; //

25 startFace 11680; //
} /

28 outlet
{

boundary patch name

patch type
no. of faces in patch
index of first face

/ => inlet patch is faces 11680-11699

29

30 ... more entries ...

31 }

32

33 walls

34 {

35 type wall; // wall type
36 ... more entries ...

37 }

38

39 frontAndBack

40 {

a1 type empty; // empty type
42 ... more entries ...

43 }

as )

45

46 /[ 3ok sk sk sk ok sk ok ok ok ok ok ok ok ok o o sk ok ok ok oK ok ok ok K 3k ok ok ok ok ok ok ok o ok ok sk o ok sk sk sk o sk ok ok kKK R KRR ok Kok ok //

2.3 Case setup and running

parallelPlate: setting initial/boundary conditions

e Field data are stored in time directories, e.g. 0,0.1, 0.2, ...

e Usually initial conditions are stored at t = 0, i.e. directory O

e The icoFoam solver reads field data for pressure (p) and velocity (U)

e Let’s look at these files.

parallelPlate: pressure field
$FOAM_RUN/parallelPlate/0/p:

17 dimensions [02-20000];

19 internalField uniform O;

(©2008-2011 OpenCFD Ltd
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2.3 Case setup and running 19
21 boundaryField
22 {
23 inlet
24 {
25 type zeroGradient;
26 }
27
28 outlet
29 {
30 type fixedValue;
31 value uniform 0;
32 }
33
34 walls
35
36 type zeroGradient;
37 }
38
39 frontAndBack
40 {
41 type empty;
42
43 }

Dimensions are m?/s?, i.e. kinematic pressure, in icoFoam
)

Internal (and boundary) fields can be:

uniform a single value

nonuniform all values in a List

type describes the numerical boundary condition

walls are zeroGradient

outlet is fixedValue which requires a value; can be anything (pressure
is relative), use 0 for convenience

frontAndBack planes of a 2D case must be empty to match their base

type

parallelPlate: velocity field
$FOAM_RUN/parallelPlate/0/U:

dimensions

internalField

boundaryField

{

inlet
{

type
value

[01-10000];
uniform (0 0 0);

fixedValue;
uniform (1 0 0);

(©2008-2011 OpenCFD Ltd
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2.3 Case setup and running 21

20 Flow between parallel plates

Case file syntax: specific
27 }

- ‘{’uuet e OpenFOAM uses a flexible I/0O format based mainly on a keyword syn-

31 type zeroGradient; tax
gen

34 zalls <keyword> <dataEntryl> ... <dataEntryN>; // usually 1 entry

36 type fixedValue;
a7 value uniform (0 0 0);

38 }
40 frontAndBack

e A data entry can be a string ("hello"), word (hello), integer (3) scalar
(3.14), ...

42 type  empty; e ...a dictionary: curly brackets {...}
}

. keyword entries ...
e Velocity is a vector field

e No-slip walls: e ...a list: round brackets (...)

List<Type> // optional, Type = elements of list, e.g. scalar

— a fixedValue type <n> // optional, number of entries
. (
— requires a value . dataEntryl ...
)3
e uniform (1 0 0) on inlet
e ...a dimensionSet: square brackets [...]

e uniform (0 0 0) on walls
[1-1-200001 // [ Mass Len. Time Temp. Qnt. Cur. Lum. ]

e outlet is zeroGradient
) ) ) Dimensions and dimension checking
e File syntax is easy to interpret!
e Fields and properties have dimensions associated with them
Case file syntax: general
e Specified as powers of: 1) mass; 2) length [L|; 3) time [T]; 4) temperature;

e Follows general principles of C-++ source code 5) quantity; 6) current; 7) luminosity

e Files have free form e Velocity is L'T!, d.e. [0 1 -1 0 0 0 0]

— No particular meaning assigned to a column e For +, — and = operations, solver stops if dimensions are not the same

No need to indicate continuation across lines e For x and / operations, dimensions are modified

e Lines have no particular meaning except to a // comment delimiter

R i ; o e Dimensions only relate to a specific system of units, e.g. SI, if physical
which ignores text that follows it until the end of line

constants (e.g. R, psq) are used

e Enclose text between /* and */ delimiters to comment over multiple
lines

e Physical constants read from the global controlDict file in etc direc-
tory $WM_PROJECT_DIR/etc/controlDict:

©2008-2011 O CFD Ltd OpenVFOAM 171 (©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenVFOAM-l.Tl
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2.3 Case setup and running 23

5 Flow between paralle] plates

DimensionedConstants parallelPlate: control parameters
879

880

$FOAM_RUN/parallelPlate/system/controlDict:

881 // SI units
882 //- Universal gas constant [J/(kmol K)]
883 R 8314.51; 20 startFrom startTime;
884 w ” Yot 43 —
b 7% USCS units j; ——— 0; Start time t = 0
886 //- Universal gas constant [1bm ft2/(s2 kmol R)] 23
887 R 3406.78; 24 stopAt endTime; . i
888 ; J End time t = 0.3
889 */ 26 endTime 0.3;
890 } 27 .
28 deltaT 0.0002;  — Time step At = 0.0002
29
1 3 30 writeControl runTime;
parallelPlate: physical properties 31 Writes out every 0.05s
32 writelnterval 0.05;
33
. . . . . 3 elirit 0; - ewrit or time directories
e What properties do I need to set in an icoFoam simulation? . RS Dies nof: rewrite pver-tine-diree
36 writeFormat ascii; . ASC _
e Look in the case constant directory 5% writePrecision 6; Writes ASCII, 6 sig. figs
39
>> 1s -1 constant 40 writeCompression uncompressed; _ \Writes uncompressed
olyMesh a1 ;
E P ; 42 timeFormat general; .
Eansportiroperties 43 ) . Time dir. naming format, 6 sig. figs
44 timePrecision 6;
. > . . 15 . . . &
e Most properties files are named ...Properties, so here just transp- 46 runTimeModifiable yes; ~ Allows modification of settings during run
ortProperties

; . " . Parameter options
e [t contains only an entry for kinematic viscosity v p

15 nu nu [02-1000 0] le-04; e O: How does a user find out what entries are valid for a particular

. . ' _ o keyword?
e The keyword nu requires a dimensionedScalar entry, which includes

e A: If keyword entry is invalid, OpenFOAM prompts the user with valid

word “nu”, used for internal naming of :
, used for internal naming of other fields entries, e.g.

dimensionSet specifying m?/s e . :
— Setting “stopAt xxx;” in controlDict, a solver would return:

scalar a value set to 1e-04 ) ; )
XXX is not in enumeration:

4

(

endTime
writeNow
noWriteNow
nextWrite

e v = 107" corresponds to Re = 400, for [U| = 1 and h = 0.01

L
Re = Ul where L = 4h

14

file: ::stopAt at line 24.

— Entries for “stopAt” are clearly listed

COTEREETETTTTLLLLLLLLLNN
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- Flow between parallel plates

parallelPlate: other control parameters

e What other control parameters can I set for an icoFoam simulation?

e Look in the case system directory

>> 1s -1 system
controlDict
fvSchemes
fvSolution

e Let’s discuss details of fvSchemes and fvSolution later

parallelPlate: running the case - initialising

>> icoFoam
/

\I
|
/ F ield | OpenFOAM: The Open Source CFD Toolbox
/ 0 peration | Version: 1.7.1
A nd | Web: www.OpenFOAM.org
M anipulation |
/
: icoFoam
Date : Apr 15 2010
Time 1 13:07:42
Host  : manfred
PID : 5668
Case : $FOAM_RUN/parallelPlate
nProcs

SigFpe : Enabling floating point exception trapping (FOAM_SIGFPE).

[/ %% a s s s aans s ann s rnarr o ershorrrtrnstnn//
Create time

Create mesh for time = 0
Reading transportProperties
Reading field p
Reading field U

Reading/calculating face flux field phi

e Creates mesh, reads physical properties and fields

parallelPlate: running the case - start

continued. ..
Starting time loop
Time = 0.0002

Courant Number mean: 0 max: 0.4
DILUPBiCG: Solving for Ux, Initial residual = 1, Final residual = 1.30079e-07, No Iterations 2
DILUPBiCG: Solving for Uy, Initial residual = 0, Final residual = 0, No Iterations 0

DICPCG: Solving for p, Initial residual = 1, Final residual = 7.75518e-07, No Iterations 163

time step continuity errors : sum local = 5.17011e-10, global = 3.2103e-13, cumulative = 3.2103e-13
DICPCG: Solving for p, Initial residual = 0.000146046, Final residual = 5.91098e-07, No Iterations 140
time step continuity errors : sum local = 2.41625e-07, global = -1.47373e-09, cumulative = -1.47341e-09
ExecutionTime = 0.31 s ClockTime = 1 s

Time = 0.0004

Courant Number mean: 0.102403 max: 0.401517

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011
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2.3 Case setup and running

25

DILUPBiCG: Solving for Ux, Initial residual = 0.991042, Final residual = 6.13964e-07, No Iterations 2
DILUPBiCG: Solving for Uy, Initial residual = 0.338071, Final residual = 1.16197e-06, No Iterations 2
DICPCG: Solving for p, Initial residual = 0.00191905, Final residual = 8.00036e-07, No Iterations 147
time step continuity errors : sum local = 2.77161e-07, global = -3.18057e-09, cumulative = -4.65398e-09
DICPCG: Solving for p, Initial residual = 0.00481002, Final residual = 6.91451e-07, No Iteratioms 147
time step continuity errors : sum local = 1.78984e-08, global = 1.30046e-10, cumulative = -4.52393e-09
ExecutionTime = 0.45 s ClockTime = 1 s

Time = 0.0006

Courant Number mean: 0.102409 max: 0.403097

DILUPBiCG: Solving for Ux, Initial residual = 0.178209, Final residual = 5.56988e-07, No Iterations 2
DILUPBiCG: Solving for Uy, Initial residual = 0.197402, Final residual = 7.33383e-07, No Iterations 2
DICPCG: Solving for p, Initial residual = 0.0168414, Final residual = 6.50678e-07, No Iterations 146
time step continuity errors : sum local = 9.03965e-10, global = 9.43093e-12, cumulative = -4.5145e-09
DICPCG: Solving for p, Initial residual = 0.0013938, Final residual = 8.0808e-07, No Iterations 141
time step continuity errors : sum local = 1.07365e-09, global = 1.19456e-11, cumulative = -4.50255e-09
ExecutionTime = 0.59 s ClockTime = 1 s

parallelPlate: running the case - end

continued. ..
Time = 0.2998

Courant Number mean: 0.102818 max: 0.596245

DILUPBiCG: Solving for Ux, Initial residual = 1.44075e-07, Final residual = 1.44075e-07, No Iterations O
DILUPBiCG: Solving for Uy, Initial residual = 1.69237e-06, Final residual = 1.69237e-06, No Iterations 0
DICPCG: Solving for p, Initial residual = 1.25578e-06, Final residual = 9.8682e-07, No Iterationms 1

time step continuity errors : sum local = 2.37135e-10, global = -7.3208e-11, cumulative = -1.43971e-08
DICPCG: Solving for p, Initial residual = 1.23148e-06, Final residual = 9.78693e-07, No Iterations 1
time step continuity errors : sum local = 2.35182e-10, global = -6.76382e-11, cumulative = -1.44647e-08
ExecutionTime = 106.03 s ClockTime = 119 s

Time = 0.3

Courant Number mean: 0.102818 max: 0.596246

DILUPBiCG: Solving for Ux, Initial residual = 1.42147e-07, Final residual = 1.42147e-07, No Iterations
DILUPBiCG: Solving for Uy, Initial residual = 1.67561e-06, Final residual = 1.67561e-06, No Iterations
DICPCG: Solving for p, Initial residual = 1.32791e-06, Final residual = 9.20289e-07, No Iterations 47
time step continuity errors : sum local = 2.21148e-10, global = -8.8838e-13, cumulative = -1.44656e-08
DICPCG: Solving for p, Initial residual = 1.17776e-06, Final residual = 6.49667e-07, No Iterations 1
time step continuity errors : sum local = 1.56118e-10, global = 1.17773e-11, cumulative = -1.44538e-08
ExecutionTime = 106.14 s ClockTime = 119 s

co

End

Courant Number

Time = 0.01
Courant Number mean: 0.102409 max: 0.403097

e Courant Number Co = UAt/Azx

e U is the flow speed in a given direction

Atz is the cell length in a given direction

e At is the time step

Co > 1 means the flow can pass through a cell within one time step

e Some numerical methods/algorithms stable only when Co is below a
particular limit
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2 Flow between parallel plates

parallelPlate: screen output

DILUPBiCG: Solving for Ux, Initial residual = 0.178209, Final residual = 5.56988e-07,
No Iteratiomns 2

DILUPBiCG: Solving for Uy, Initial residual = 0.197402, Final residual = 7.33383e-07,
No Iterations 2

DILUPBiCG is the chosen linear-solver for the U equation

e Linear-solver decouples vector equation for U into components Ux
and Uy
e [terates until Final residual < tolerance
e fvSolution::solvers (solvers subdictionary of fvSolution):
28 U
29 {
30 solver PBiCG;
31 preconditioner DILU;
32 tolerance le-05;
33 relTol 0;
34 }

parallelPlate: screen output (2)

DICPCG: Solving for p, Initial residual = 0.0168414, Final residual = 6.50678e-07,
No Iterations 146

time step continuity errors : sum local = 9.03965e-10, global = 9.43093e-12,
cumulative = -4.5145e-09

DICPCG: Solving for p, Initial residual = 0.0013938, Final residual = 8.0808e-07,
No Iterations 141

time step continuity errors : sum local = 1.07365e-09, global = 1.19455e-11,
cumulative = -4.50255e-09

ExecutionTime = 0.03 s ClockTime = 0 s

e DICPCG is the chosen linear-solver for the p equation
e p equation solved 2 times according to the PISO correctors nCorrectors
e Errors in mass continuity presented as:

— sum local: sum of magnitudes of continuity errors in each cell
— global: across the boundary of the domain

— cunulative: global error accumulated over time

fvSolution: :solvers:

©2008-2011 OpenCFD Ltd OpenVFOAM-1.7.1
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20 p
21 {

22 solver PCG;
23 preconditioner DIC;
24 tolerance 1e-06;
25 relTol 0;

26 }

fvSolution: :PISO:

37 PISO

a8 {

39 nCorrectors 2

40 nNonOrthogonalCorrectors 0;
41 pRefCell 0;

42 pRefValue 0;

43 }

2.4 Post-processing

Post-processing a mesh

e Run paraFoam:

>> paraFoam
e Check the Mesh Parts and Volume Fields box
e Click the Apply button

e Select the Display panel

1199999499413 11

e In Style: select Wireframe representation

e Set Color by Solid Color

Edit Set Solid Color, e.g. black

Useful settings in paraview

In Edit -> View Settings:

e General panel:

Set Background Color white for printed material
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Use Parallel Projection usual for CFD, especially 2D cases
e Lights panel:

Default Light Set to on, strength 1, white
e Annotation panel:

Orientation Axes Set to on, Interactive, Axes Label Color black

In Edit -> Settings:
e Render View - General panel:

Level of Detail (LOD) controls the rendering while image is manip-
ulated; ‘smaller numbers speed things up’

e Colors panel controls global colour settings

Paraview toolbars

Current Time Controls

Main controls Undo/Redo Controls

Selection Controls VCR Controls

| |

I L ] L 1] L

e w ? AN b SAEL G9 O K < > > bl % Tme|o 54 IS

0 (@ ) (sweee [ 30 s 43 18 3 82, (6@ G
S00I - 0526

Common Filters
Active Variable Controls | Representation Centre Axes Controls

Camera Controls

Pressure field plot

Pressure, p (m ™~ 2/s ™ 2)
0.40 0[%0 1.20
(| I Ll UL &

0.00 1.49

e Current Time Controls toolbar:
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2.4 Post-processing 29

— Change time to t = 0.3 s
e Active Variable Controls toolbar:

— Color by — °P
— Surface representation.

— Rescale to Data Range if required

Also:
e Color by — @r attributes single value for pressure to each cell
e For a colour bar, select Toggle Color Legend Visibility and configure with
Edit Color Map

Velocity vector plot

e We want vectors at cell centres

— Select Cell centers from the top Filter menu
— Click Apply

e Select Glyph from the Filter menu
— Open Parameters panel

— Glyph — Arrow
— Scale Mode — off

Specify Scale Factor 0.001
— Set Max. no. of points to 20,000

e Colour the glyphs by velocity magnitude
— Display panel — Color by U
e Edit Color Map — Color Legend.

— Uppercase Times Roman font

— Deselect Automatic Label Format and enter %-#6.2f in Label Format
to fix to 2 sig. figs.
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30 Flow between parallel plates

040 0.80 1.20

Sampling data along a line

e We want to plot graphs of velocity profile and compare with the analyt-
ical solution

e The GUI post-processing is not particularly useful; graphing is not very
good

e Instead we can use the sample utility
e Easy to automate/configure with a sampleDict configuration file
e Examples can be found in the release

>> find $FOAM_TUTORIALS -name sampleDict

e Let’s copy one of those

>> cp $FDAM_TUTORIALS/compressib1e/rhoCentralFoam/shockTube/system/sampleDict system

2.4 Post-processing 31

Configuring the sample utility

e We will monitor the velocity across the channel at z = 0.29 (near the
outlet)

e Change the sets entry in the sampleDict file

sets
(
acrossFlow
type midPoint; // samples at mid-point between faces
start ( 0.29 -0.011 0 );
end (0.29 0.011 0 );
axis v // prints the y ordinate at each sample point
}
)s

e Change the fields entry in the sampleDict file

fields ( U ); // sampling velocity field U

e Execute the sample utility

>> sample

e Results are written into sets directory
Plotting results using gnuplot

e We will use gnuplot to plot graphs

e Can be run with configuration files

e Pre-configured files in $FOAM_RUN/EXAMPLES/gnuplot
e Copy this directory into our system directory

>> cp -r $FOAM_RUN/EXAMPLES/gnuplot system

e Use the configuration file called plot_parallelPlate:

dPdx = -3
mu = le-04
h = 1le-02

(©2008-2011 OpenCFD Ltd
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set parametric

plot [-h:h] -dPdx/mu/2*(h**2 - t**2),t title "Analytical", \
"sets/0.15/acrossFlow_U.xy" using 2:1 title "t = 0.15", \
"sets/0.3/acrossFlow_U.xy" using 2:1 title "t = 0.30"
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39 Flow between parallel plates

Plotting results using gnuplot (2)

e Execute gnuplot

>> gnuplot
gnuplot> load "system/gnuplot/plot_parallelPlate"

0.01 T T T T T T A
NS nalytical
R ———
B t=015 -
o SN t=030 x
0.005 : B

-0.005

-0.01

1.6

2.5 Mapping one case to another

Increasing mesh resolution

e Clone the parallelPlate case to make parallelPlateFine

>> run # alias for cd $FOAM_RUN
>> mkdir parallelPlateFine

>> cp -r parallelPlate/system parallelPlateFine

>> cp -r parallelPlate/constant parallelPlateFine

>> cd parallelPlateFine

e Refine mesh to 40 cells across the channel

— In blockMeshDict change blocks to

31 blocks

32

33 hex (0123456 7) (300 40 1) simpleGrading (1 1 1)
34 pin

— Run blockMesh

©32008-2011 OpenCFD Ltd V1.7.1 rev 7. 3/5/2011 OpenVFOAM-1.7.1
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Field mapping

e Fields can be mapped from one mesh to another with mapFields utility

e Mapping between conforming geometries/fields done with -consistent
option

e Otherwise, mapping on patches specified in mapFieldsDict file

- - = Source field geometry
—— Target field geometry
[ Region of no mapping

1
1

Coincident patches:
e we} mapped using patchMap

Internal target patches:
. can be mapped using cuttingPatches

parallelPlateFine: mapping, then running case in background

e Map consistent fields from parallelPlate case at t = 0.3

>> mapFields ../parallelPlate -consistent -sourceTime 0.3

e Fields are written into 0 directory

e Run the case using foamJob script to output to a log file

> foamJob icoFoam

Application : icoFoam

Executing: $WM_PROJECT_DIR/applications/bin/linuxGccDPOpt/icoFoam
> log 2>&1 &

e View the log file in the terminal window or an editor. Useful is:

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenVFOAM-1.7.1
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34 Flow between parallel plates

>> tail -f parallelPlateFine/log
e Terminate with Control-C
Results from fine mesh
e Run the sample on parallelPlateFine
>> sample

e Plot the results; note the better results from the finer mesh

>> gnuplot
gnuplot> load "system/gnuplot/plot_parallelPlateFine"

001 "\'\_!*_\x\l‘ T T T T T

Analytical

T e 20 cells

T 40 cells  x
0.005 |- e il
0| i
-0.005 |- ,/x/"”)/w 1
/x/*/
*"_’4e,ﬂ_—*/f/4*/
-0.01 "1 | | l 1 1 |
0 0.2 0.4 0.6 0.8 1 1.2 1.4 1.6

2.6 Example boundary conditions
Boundary conditions (BCs) in OpenFOAM

e Geometry boundary is broken into patches on which BCs are applied

e Patch types (BCs) relating to geometry, e.g. symmetry plane, are as-
cribed on the mesh in OpenFOAM

— Specified through type keyword in constant/polyMesh/boundary

e For fields, we specify actual numerical BCs, e.g. fixedValue for U,
zeroGradient for p (rather than “inlet”)

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenVFOAM-l.Tl
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— Specified through type keyword in boundaryField of field files,
e.g. 0/p
— Can be simple fixedValue, zeroGradient, fixedGradient, ...

— ...or amore complex “derived” patch type flowRateInletVelocity,
totalPressure, ...

Geometry boundary types

e Boundary patches are given a geometric type in OpenFOAM
— See the boundary file of a mesh
e The default type is patch

e There are other special types relating to geometry or data communcation

Selection Key Description

patch generic patch

symmetryPlane plane of symmetry

empty front and back planes of a 2D geometry

wedge wedge front and back for an axi-symmetric geometry
cyclic cyclic plane

wall wall — used for wall functions in turbulent flows
processor inter-processor boundary

Parallel plate flow with symmetry plane

J wall
A O A 2
N ::\ 6
[ ik
0 N T ) ) T e S e e e e e S 5 B S SRS T e T \
4 bl 5 s i s [ G o ) ) o (67 ] & 5 6 e § ] 35 5] ! 3 [ —_ 5
Z centreline

e Laminar flow is symmetric; let’s put a symmetry plane along the flow
centreline

1. Create a parallelPlateSymm case by cloning the parallelPlate case;
for convenience, type
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36 Flow between parallel plates

>> run

>> cp -r parallelPlate parallelPlateSymm
>> cd parallelPlateSymm

>> rm -rf 0.%

Parallel plate flow with symmetry plane (2)

2. Edit the constant/polyMesh/blockMeshDict file

e vertices: change the “~1” y-ordinate to “0”
e patches: create the centreline patch and modify the walls patch
by:
yall walls
(376 2)

symmetryPlane centreline

(1540)

3. Run blockMesh

4. Edit the 0/p and 0/U files; in boundaryField sub-dictionary, add a new
patch entry

centreline { type symmetryPlane; }

5. Run icoFoam
Parallel plate flow with symmetry plane (3)

6. Run sample

7. Plot the results using gnuplot

>> gnuplot
gnuplot> load "system/gnuplot/plot_parallelPlateSymm"
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0.01 = T T
+“=\J*\V ] I l l Analytical
- t=030 +
0.008 |- \'\,\ 1
S
T

0.006 - \\"\\ |

0.004 - *\\\ y

0.002 )\i =
0 1 | 1 1 1 1 1

0 0.2 0.4 0.6 0.8 1 1.2 1.4 1.6

Poiseuille flow (1)

e Laminar flow in a cylinder has the analytical solution (Poiseuille):

8v
" R?

(VP)I

U = - 4v

(R2 - y2) (Vp):n =

e Can be simulated as 2D axisymmetric using wedge patches

e Define a block with 2 wedge patches

wedge P
e

Axis of symmetry
. - '

wedge patch 1

wedge aligned along coordinate plane
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Flow between parallel plates

2.6 Example boundary conditions 39

Poiseuille flow (2)

T

\

centreline

1. Create a poiseuille case by cloning the parallelPlateSymm case

>> run

>> cp -r parallelPlateSymm poiseuille

2. Vertex pairs are collapsed along the centreline — blockMesh supports
this; edit the constant/polyMesh/blockMeshDict file

19
20
21
22
23
24
25
26
27

vertices

// approx tan(0.6 deg)

¥

Poiseuille flow (3)

3. Modify the blocks and patches accordingly

29
30
31
32
33
34
35
36
37
38
39
40
41

blocks
hex (01 23014 5) (300 20 1) simpleGrading (1 1 1)
)5
patches
(
patch inlet ( (0 0 5 3) )
patch outlet ( (2 41 1) )
wall walls ( (354 2))
wedge front ( (0 14 5) )
wedge back ( (0 3 2 1) )
)5

4. Run blockMesh

5. Edit the 0/p and 0/U files; in boundaryField sub-dictionary:

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011
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e add new patch entries

front { type wedge; }
back { type wedge; }

e frontAndBack and centreline can be removed

6. Run icoFoam
Poiseuille flow (4)

7. Run sample
8. Plot the results using gnuplot

>> gnuplot
gnuplot> load "system/gnuplot/plot_poiseuille"

0.01 T T T
— Analytical
il SV t=030 +
0.008 |- \\\ —
TSk
0.006 |- \,\\ 4
0.004 ) =
0.002 | B
0 1 1 i
0 0.5 1 15 2

Parallel plate flow: pressure inlet BC (1)

e Let’s try specifying pressure at the inlet instead of velocity

e Create aparallelPlatePinlet case by cloning the parallelPlateSymm
case

>> run
>> cp -r parallelPlateSymm parallelPlatePinlet

e Change the inlet BC to fixedValue in the 0/p file

e A value of 0.9 gives (Vp), = (0.0 — 0.9)/0.3 = —3 as before
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inlet
type fixedValue;
value uniform 0.9;
}

e Recall that (Vp), oc Q: we can specify (Vp), or Q, not both
e If we now run with fixedValue on velocity, the problem is overspecified

— Sudden jumps in p and U will appear at the inlet if inlet values are
mismatched (i.e. (Vp), and @ don’t equate)
— Can cause the code to blow up

Parallel plate flow: pressure inlet BC (2)

e Change the inlet BC to pressureInletVelocity in the 0/U file

inlet
type pressurelnletVelocity;
value uniform (0 0 0);

e pressurelnletVelocity is a fixedValue BC that sets U = ¢n¢/|S¢
(¢ = flux; ny = unit face area vector; |S¢| = face area magnitude)

e Pressure gradient accelerates the flow to steady-state

e = solution slow to converge, so set endTime (in controlDict) to 3
e Run icoFoam

e Smooth solution produced

Profile is same along the length, i.e. no plug flow (constant velocity
profile) at inlet

e ...but convergence was much slower than with velocity inlet

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011
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2.7 Introduction to turbulence modelling

Increasing the Reynolds number

e Aim: to run the Poiseuille case with Re = 10?

e Schlichting Boundary Layer Theory gives an approximate solution for
the velocity profile for this case

<

5 y\1/7 nd -
U‘,,NZQ(17§> for 10* < Re < 10

e Let’s choose v = 2 x 1076, = Re = 2R|U|/v = 10*
e No longer laminar — icoFoam no longer suitable

e Examine the Description in the .C files in the $FOAM_SOLVERS/incom-
pressible directory, e.g.
>> cd $FOAM_SOLVERS/incompressible

>> find . -name "*.C" -exec grep -H -A3 Description {} \;
./pisoFoam/pisoFoam.C:Description

./pisoFoam/pisoFoam.C- Transient solver for incompressible flow.
./pisoFoam/pisoFoam.C-

./pisoFoam/pisoFoam.C- Turbulence modelling is generic...

e pisoFoam suitable

e We will use Reynolds-averaged stress (RAS) turbulence modelling
Copying case files

e We need poiseuilleHighRe case for the pisoFoam solver

e The poiseuille case files are set up for icoFoam

e = we should copy a pisoFoam case. ..

e then copy any poiseuille case files that can be reused, e.g.

Mesh constant/polyMesh/*
Fields 0/*

Sampling system/sampleDict
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49 Flow between parallel plates

2 . . . . 9 |/ .
: e Initialise isotropic turbulence U,? = U;? = U.? = 5% of the inlet

velocity

3 5 2 3 2,92
k= ( ) =3.75 x 107% m*/s”

Controls system/controlDict
e Then modify other files, e.g. turbulent modelling and fields

e To save time/typing, use pre-configured case in EXAMPLES directory ’ 2 100
>> run

>> cp -r EXAMPLES/poiseuilleHighRe . e Assume a turbulent length scale L = 20% of the tube diameter (C,, = 0.09)

Turbulence simulation and RAS modelling _ Cﬁ”k,lﬁ

L

£

~94x1073 1‘112/83

e The type of turbulence modelling is specified under simulationType in 3

constant/turbulenceProperties from: Wall functions

laminar uses no turbulence models
RASModel uses RAS modelling;
LESModel uses large-eddy simulation (LES) modelling

Wall functions are specified through boundary conditions on turbulent
viscosity v

In this case a standard wall function is specified by the nutWallFunc-

. i ype e aries, see 0/nut
e The choice of Reynolds-averaged stress (RAS) turbulence model is then 9%, e 4 vl benndaries, 5o Gt

set in constant/RASProperties, containing: e epsilonWallFunction must be specified on corresponding patches in

the 0/epsilon

Keyword Description )

RASModel Name of RAS turbulence model g e kgRWallFunction must be specified on corresponding patches in the
turbulence Switch to turn turbulence modelling on/off = turbulent fields k, q and R (k in this case)

printCeoffs Switch to print model coeffs to terminal at simulation startup

<RASModel>Coeffs Optional dictionary of coefficients for the respective RASModel .

Turbulence field example (1): k

e We select the £ — € model

. 18 dimensions [02-2000 0];
19
18 RASModel kEpsilon; 20 internalField uniform 0.00375;
19 = 21
20 turbulence on; 22 boundaryField
91 2
22 printCoeffs on; - o, 1 inlet
25 {
g 26 type fixedValue;
Initialising turbulence fields o ; value i e OIS
- 29 walls
30 {
e The k — & model contains two new fields - 31 type kqRWallFunction;
32 value uniform 0.00375;
. 33
— Turbulent kinetic energy k = U’+U’/2 ) 34 outlet {type zeroGradient;}
e 35 back  {type wedge;}
— Turbulent dissipation rate £ = (7:1)'7"’11"1"’/12 < 36 , front {type wedge;}
37

: (©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenVFOAM-l,M
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44 Flow between parallel plates

Turbulence field example (2): nut

18 dimensions [02-10000];

20 internalField uniform 0; // Overridden by the code

22 boundaryField

23 {

24 inlet

25

26 type calculated;
27 value uniform O;
28

29 walls

30 {

31 type nutWallFunction; // The only entry of importance
32 value uniform O;
33

34 outlet {type zeroGradient;}
35 back  {type wedge;}

36 front {type wedge;}

37}

Incompressible transport models

Need to set v = 2 x 1079 for Re = 10*

e pisoFoam uses the incompressibleTransportModels library

e More options in constant/transportProperties:
17 transportModel Newtonian;
18
19 nu nu [02-100001] 2e-06;
L]

Running the pisoFoam solver

Run pisoFoam

>> foamJob pisoFoam

Run sample

Run gnuplot on a new configuration file called plot:

User selects the transportModel, then necessary values/coeffs

Converges a bit slower than before: = set endTime to 0.5 in controlDict

©2008-2011 OpenCFD Ltd
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Introduction to turbulence modelling

45

h = 0.01

set parametric ) )

plot [0:h] 5.0/4.0%(1.0 - t/h)**(1.0/7.0),t title "Analytical", \
"sets/0.5/acrossFlow_U.xy" using 2:1 title "Numerical"

0.01 T e T T T T

+ Analytica
+ ~ Numerical

0.008

0.006

T

0.004

0.002 -

14
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Dam break

3 Dam break

3.1 Subsetting a mesh
Dam break

e Water column release

e Use the interFoam solver

e Different set up to the User Guide

e Geometry in inches (in)

e Dimensions divisible by 0.25 in

e Let’s create a uniform cell size 0.25 x 0.25 in
e Let’s create a single block. . .

e ...then cut out the 2 x 1 in obstacle

e Retain the same patches
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atmosphere

23.00 in

leftWall rightWalll

|~ ~L

water column

23.00 in

11.50 in

I_l 2.00 ilf | ¢

> — 4-100 in

5.75in 5.75 in lowerWall

Modifying the tutorial damBreak case
e Copy the tutorial interFoam/damBreak case locally
>> cp -r $FOAM_TUTORIALS/multiphase/interFoam/laminar/damBreak .

e Create a single 2D block with 92 x 92 cells, in blockMeshDict:

17 convertToMeters 0.0254; // inches to metres conversion

19 vertices
20
21 (0 0 -1)
22 (23 0 -1)
23 (23 23 -1)
24 (023 -1)
25 (0 0 1)
26 (23 0 1)
27 (23 23 1)
28 (023 1)
29 2
30
31 l()locks
32
33 hex (0 1 23456 7) (92 92 1) simpleGrading (1 1 1)
34 i3
©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenVFOAM-lIl




48 Dam break

Patches blockMesh
e Now create patches using existing patch names

40 patches

41 (

42 wall leftWall
43

44 y (0 47 3)
45

46 wall rightWall
a7 (

48 (1 26 5)
49

50 wall lowerWall
51

52 (015 4)
53

54 patch atmosphere
56 (2376
57

58 5

e Run blockMesh

Subsetting mesh

e subsetMesh utility: creates a subset of a mesh from a cell set
e cellSet utility: creates a set of cells based on cellSetDict

e Copy an example cellSetDict file to system directory

>> cp $FOAM_UTILITIES/mesh/manipulation/cellSet/cellSetDict system

e Edit the file accordingly:
17 name cO;

18 action new; // use this on 1st cellSet run
19 //action invert; // use this on 2nd cellSet run

21 topoSetSources

23 : boxToCell

25 { box (0.2921 0 -1) (0.3175 0.0508 1);
27 ),

e Run cellSet: with action new; to create a cell set of the obstacle

e Run cellSet again: with action invert; to create a set of all cells
except the obstacle

e Run subsetMesh on the cell set c0, merging new faces into patch lowerWall

>> subsetMesh cO -patch lowerWall -overwrite
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Final mesh

e -overwrite option puts mesh in constant

e Without this option, time is incremented before writing to prevent the
mesh being overwritten

3.2 Nonuniform initial fields

Setting nonuniform initial field

e Volume of Fluid (VoF) method solves for fraction « of fluid phase(s)

e Nonuniform initial condition for the phase fraction of phase 1 a; (alphal)

1 for pure phase 1 (liquid)
0 for pure phase 2 (gas)

e setFields: initialises nonuniform fields according to setFieldsDict

18 defaultFieldValues // specify default values

19 (
20 volScalarFieldValue alphal O
21 ;
22
23 regions // specify regions of different values
24
25 ?oxToCell // uses same mesh set tools as cellSet
26
27 box (0 0 -1) (0.146 0.292 1);
28 fieldValues
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29 (
30 volScalarFieldValue alphal 1
31 H
32 }
33 s

e Now look at the 0/alphal file; note the boundary conditions

Transport and interface properties

e transportProperties is split into two subditionaries phasel and phase2

e Each subdictionary includes a transportModel for the phase

— If Newtonian, kinematic viscosity specified under the keyword nu

— If another model, e.g. CrossPowerLaw, viscosity parameters are
specified in a further subdictionary, e.g. CrossPowerLawCoeffs

The surface tension, a property of both phases, is specified by sigma

The damBreak case uses properties of water and air

Gravitational acceleration is specified as a uniformDimensionedField
in the constant/g file

Discretisation schemes

e OpenFOAM’s interface tracking solvers use OpenCFD’s multidimen-
sional universal limiter for explicit solution (MULES) method

— maintains boundedness of alphal...

— ...independently of the underlying numerical scheme and mesh
structure

e = choice of convection scheme not restricted to those that are strongly
stable or bounded, e.g. upwind differencing

e A reliable set of convection schemes is set up in system/fvSchemes

1 divSchemes

2

3 div(rho*phi,U) Gauss limitedLinearV 1;
4 div(phi,alpha) Gauss vanLeer;

5 div(phirb,alpha) Gauss interfaceCompression;
6

e Run the case!!
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Results

e Field plot of phase fraction alphal at t = 0.25 s and at t = 0.50 s
Creating an animation

e The case can be animated in ParaView by clicking Play in the animation
toolbars

e An animation can be saved by selecting File -> Save Animation
— Writes a set of image frames, e.g. in PNG format, damBreak*png

e Can be converted into an animation, e.g. in MPG format with the
convert utility in the ImageMagick package

>> convert -quality 100% damBreak*png damBreak.mpg

e OR directly using mencoder

>> mencoder "mf://*.png" -mf fps=2 -o damBreak.mpg -ovc lavc -lavcopts
vcodec=mpeg4:autoaspect

e The animation can be played with mplayer

>> mplayer -loop O damBreak.mpg
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™

= Dam break 3.3

3.3 Running in parallel Parallel running

Parallel running overview e The case should be split into processor<n> directories, each containing

its own part of the mesh and fields

e Parallel computing in OpenFOAM uses domain decomposition z
>> 1s damBreakPar

: . . . 0 constant processorQ0 processorl system
o Geometry and associated fields are broken into pieces and allocated to

separate processors ’ e The case can be run in parallel using mpirun; the solver must be executed

! i sbs : with the -parallel option
e decomposePar: performs domain decomposition using decomposePar- P I

Dict configuration file >> cd damBreakPar
- >> mpirun -np 2 interFoam -parallel
e Simple geometries: use hierarchical decomposition
e Check there are 2 processes running, e.g. (kill with CTRL-C)
e Complex geometries: use scotch decomposition

>> top
PID USER PR NI VIRT RES SHR S %CPU %MEM TIME+ COMMAND
Domain decomposition . 18767 chris 25 0 184m 17m 10m R 101 1.7 0:04.28 interFoam

18768 chris 25 0 184m 17m 10m R 99 1.7 0:04.25 interFoam

e Let’s run damBreak case on 2 CPUs or 2 cores

Parallel running options
e Clone the damBreak case to damBreakPar

>> mkdir damBreakPar ' e Running on a cluster, a user wishes to run from machine aaa on the
>> cp -r damBreak/0 damBreak/[cs]* damBreakPar following machines: aaa; bbb, which has 2 processors; and ccc

e Modify the system/decomposeParDict file to 2 domains split in the e The user should create a file, e.g. machines, containing:
z-direction y
= 1 aaa
- 2 bbb cpu=
18 numberOfSubdomains 2; // no. of subdomains for decomposition . ; ccc cpu=2
19
20 method hierarchical; // method of decomposition, simple geometries re
2 //method scotch; // method of decomposition, complex geometries e The application is run with mpirun using the option:
b l{uerarchlcalCoeffs i -hostfile /path/to/machines
25 n (2 11); // domain split into 2 in x direction e
26 order Xyz; // directions in which decomposition is done e For further information
27 delta 0.001; // set it to 0.001
48 } >> mpirun --help
30 distributed no; // is the data distributed across several disks? <

e foamJob script with -p option runs parallel cases using mpirun:
e Now execute decomposePar on damBreakPar

— automatically picks up no. of processors from no. of processor<n>
directories

— automatically uses a file named machines if present in system di-
rectory
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Post-processing and reconstruction 3 4 Programmlng background

4.1 C+-+ overview

e reconstructPar utility: reassembles decomposed fields and mesh from
processor<n> directories into normal time directories OpenFOAM Programming: language in general

e Segments of domain can be post-processed individually by treating an
individual processor<n> directory as a case in its own right, e.g. run-
ning

e The success of any language is due to efficiency in expressing concepts

Using verbal language, ‘velocity field’. ..

2 Pbionn ~vuEe ProcsspoE) — has abstract meaning without reference to the type of the flow or

specific data
— encapsulates the idea of movement with direction and magnitude

/ — relates to other physical properties

e In mathematical language, we represent velocity field by a single symbol
LU7

— Symbols can express further concepts, e.g. the field of velocity mag-
nitude by |U]|

e This is emulated in OpenFOAM

— Our velocity field can be represented by U

— “The field of velocity magnitude’ can be mag(U)

e The idea is taken much further. ..

Equation representation in OpenFOAM

e Top level code represents the equations being solved, e.g.
opU
e ot
N
1

+VepUU-V.pR=— Vp
— N — \4,./
2 3

1. Local rate of change of pU

y 2. Convective rate of change of pU
- 3. Viscous dissipation (laminar + turbulent)
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4. Pressure gradient

1 ?olve

2

s fvm: :ddt (rho, U)

4 + fvm::div(phi, U)

5 + turbulence->divRhoR (U)
6 ==

7 - fvc::grad(p)

8 );

e Uses polymorphism: objects of different classes respond differently to
functions of the same name

|

solve function behaves differently depending on the class (type) it
operates on

f-, -, == operators have been overloaded

[

divRhoR function is overridden by each turbulence model, so is
interpreted differently depending on the model selected at runtime

[

Improves code readability
Classes and objects

e Velocity is a vector field. In object-oriented programming. ..

— there could be a vectorField class

— the velocity field U would be an instance or object of that class
e Temperature, pressure, density are scalar fields

— there could be a scalarField class

— p, T, rho would be objects of that class
e C++ provides template classes, e.g. Field<Type>

— The <Type> can be scalar, vector, tensor

— General features of the template class are passed on to any class
created from it

— Reduces code duplication
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Class hierarchy

Classes Functions
List<Type> —E size()
Y
Field<Type> operator+(..., ...)

C++ allows a hierarchy of classes

Generic concepts can be defined in a base class, e.g. List<Type>

A derived class, e.g. Field<Type> can be formed from base classes

The derived class inherits attributes/behaviour of the base classes

e ¢.g. we could access the size of vectorField U with U.size()
How much C++ do we need to know?
e Users do not need a deep knowledge of C+-+ programming to work with
utilities, solvers and model libraries. . .

e ...because these top level codes are largely procedural since they repre-
sent solution algorithms

e Users need to:

— understand C++ and OpenFOAM syntax and mechanisims;
— locate classes and their functionality;

— make modifications and compile them into executables/libraries.

Class files

For a class vector

e (Class definition in vector.C:
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— a set of instructions such as object construction, data storage and
functions

e Compilation of vector.C:

— either with an application file vectorTest .C — containing the main
function — into an application executable vectorTest

— or into a shared object library OpenFOAM.so that is linked to vectorTest

e (lass declaration in vector.H:

— a list of defined functions etc., not the functions themselves
— every compiled (.C) file needs this list for the classes it uses
— the .H file must be included before any code using the class (in-

cluding the class declaration .C code itself)
#include "vector.H";

4.2 Code compilation

Compilation example: pisoFoam

1. Make a local source code directory in the user’s account and go into that
directory
>> mkdir -p $WM_PROJECT_USER_DIR/applications/solvers/incompressible
>> cd !'$

e Note: !$ or !':$ — word designator, meaning “last argument on
previous line”; i.e. the directory that has been created

2. Copy the pisoFoam source code from the installation and go into the
directory

>> cp -r $FOAM_SOLVERS/incompressible/pisoFoam .
>> cd pisoFoam

3. Change $FOAM_APPBIN to $FOAM_USER_APPBIN in the Make/files file

1 pisoFoam.C

EXE = $(FOAM_USER_APPBIN) /pisoFoam

4. Compile with wmake

>> wmake

e Let’s explain how the compilation works...
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Compilation with wmake

e OpenFOAM uses its own compilation tool wmake
e ...designed for a single package containing 100s of applications/libraries
e Application/library code requires a Make directory, containing 2 files

— files: List of compiled .C file(s) and executable name

— options: Compilation options

wmake builds a dependency list with .dep file extension, e.g. pisoFoam.dep
— Can be used to locate included files on the system

For a library, wmake creates an 1nInclude directory with links to all

source files

— A good place to search for files, e.g. $FOAM_SRC/OpenF0AM/1nInclude

wmake: the files file

e The files file contains a list of .C source files that must be compiled

— It does not need the .C files already compiled into linked libraries

— Often, the ‘list’ is just the single main .C file

e For applications, “EXE =" specifies the path/name of the compiled exe-
cutable

e For libraries, “LIB =" specifies the path /name of the compiled library

e Standard release applications are stored in $FOAM_APPBIN (libraries in
$FOAM_LIBBIN)
e User applications should go in $F0OAM_USER_APPBIN

e $FOAM_USER_APPBIN takes precedence on the system $PATH so a user
application will ‘override’ a release application of the same name

— e.g. test for pisoFoam by typing:

>> which pisoFoam
/home /ubuntu/0penF0AM/ . . ./bin/linuxGccDPOpt/pisoFoam
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Compiling and linking

Main code vector class
vectorTest.C Header file vector.H
f.tinclude. "vector.H" = option Dafisitdan, . .
int main()
{
vector d(1, 2, 3);
. vector.C
return(0) ; #include "vector.H"
¥ Code. ..

Y

Compiled Compiled

I_, vectorTest Linked OpenFOAM.so _J

Executable -1 option B Library

wmake: including headers

e The compiler searches for included files in the following directories:

1
2
3

. $WM_PROJECT_DIR/src/OpenFO0AM/1nInclude

. pisoFoam/lnInclude: a local InInclude directory

. pisoFoam: the local directory

. platform dependent paths set in $WM_DIR/rules/$WM_ARCH, e.g.
/usr/X11/include

. Other directories specified in the Make/options file with the -I
option

e The Make/options file contains the full directory paths, e.g.

S B R

EXE

INC =
_-I$(LIg_SRC)/turbulenceModels/incompressible/turbulenceModel \
-I$(LIB_SRC)/transportModels \
-I$(LIB_SRC)/transportModels/incompressible/singlePhaseTransportModel \
-I$(LIB_SRC)/finiteVolume/lnInclude

e Uses a common UNIX scripting syntax of a backslash (\) to continue
across lines
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wmake: linking to libraries

e The compiler links to shared object libraries in the following directory
paths:
1. $FOAM_LIBBIN

2. platform dependent paths set in $WM_DIR/rules/$WM_ARCH/ direc-
tory, e.g./usr/X11/1ib

3. Other directories specified in the Make/options file with the -L
option, typically

~

EXE_LIBS = -L$(FOAM_USER_LIBBIN)

e The actual library files to be linked are:
1. the libOpenFOAM.so library from the $FOAM_LIBBIN directory

2. platform dependent libraries, e.g.libom.so from /usr/X11/1ib

3. other libraries specified in the Make/options file with the -1 option,
removing the lib prefix and .so extension from the library file name

7 EXE_LIBS = \

8 -lincompressibleTurbulenceModel \
9 -lincompressibleRASModels \

10 -lincompressibleLESModels \

11 -lincompressibleTransportModels \
12 -1finiteVolume \

13 -1meshTools

Running wmake

e To compile an application, change to the application directory and type

>> wmake

e Alternatively, include the application directory path as an argument,
e.g.

>> wmake $WM_PROJECT_USER_DIR/applications/solvers/incompressible/pisoFoam

e To compile a library, go to the library directory and type

>> wmake libso
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wclean: cleaning up after wmake

e Sometimes after making code changes, or before packing a solver to send
elsewhere, .dep files need removing

e To clean an application source directory, go to the directory and type
>> wclean
e To clean a library source directory, go to the directory and type

>> wclean libso

e The rmdepall script also removes .dep files recursively down a directory
tree

4.3 Utility walk through
Utility walk through
e Let us look at a post-processing utility that creates total pressure from
static p and U
e A search in the release finds the utility ptot
e Let’s go to the source code directory
>> cd $FOAM_UTILITIES/postProcessing/miscellaneous/ptot
e It contains a file called ptot.C...

e ...and a Make directory
The fvCFD.H file

e Following the comment block at the top of ptot.C:

33 #include "fvCFD.H"

e fvCFD.H is a file containing a selection of included class header files that
are generally relevant to finite volume CFD, e.g.:

— Time.H: the Time database

/ ’
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— fyMesh.H: the finite volume mesh class

— fvc.H, fvMatrices.H, fvm.H, etc.: finite volume equation discreti-
sation

— argList.H: handles terminal argument list

— ...and more

e Some of these may not be needed, but it does not matter much; if the
application is CFD-related, just include fvCFD.H

e fvCFD.H is in $FOAM_SRC/finiteVolume/lnInclude and classes com-
piled in the finiteVolume library

e Make/options:

1 EXE_INC = \

2 -I$(LIB_SRC)/finiteVolume/lnInclude
3

1 EXE_LIBS = \

5 -1finiteVolume \

6 -lgenericPatchFields

Time and command line options

37
38
39
40
41
42
43
44

e The first part of the code is concerned with Time and command line
options

int main(int argc, char *argv[])

{
timeSelector: :addOptions();
# include "setRootCase.H"
# include "createTime.H"
instantList timeDirs = timeSelector::selectO(runTime, args);
e timeSelector::addOptions(): reads command line options that apply

utility to data from selected time directories only

e setRootCase.H: sets the root path and case directories according to the
arguments

® createTime.H: instantiate runTime of the type Time — a class that holds
information relating to time which acts as a database for the simulation

timeSelector: :select0() function returns a list of time directories to
calculate ptot for

©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011

OpenVFOAM-1.7.1




64 Programming background

Database for OpenFOAM cases

controlDict — Time runTime

fchhe@es fvMesh |mesh mesh2
fvSolution —>
Y Y Y
Properties |nu Fields |p U [Dictionaries|RASProperties

e OpenFOAM has a hierarchical database for case data
e Time: top-level objectRegistry; controls time and data reading/writing

— Object typically named runTime

— Reads controlDict
e fvMesh: next level of objectRegistry

— Object typically named mesh, but can be more than one

— Reads fvSchemes and fvSolution

e Fields, properties, dictionaries registered with a particular fvMesh

Creating a mesh and looping over times

46 # include "createMesh.H"

a7

48 forAll(timeDirs, timeI)

49

50 runTime.setTime (timeDirs[timel], timel);

e createMesh.H: instantiates mesh of type fvMesh — finite volume mesh

4 EvMesh mesh

6 I0object

8 ( fvMesh: :defaultRegion,
9 runTime.timeName (),

10 runTime,

11 I0object: :MUST_READ

12 )

13 );

e runTime set to particular time from the timeDirs list

i
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Info statements

e The next line is an Info<< statement

52 Info<< "Time = " << runTime.timeName() << endl;

e Messages (terminal) written by Info messageStream, syntax:

1 Info<< "messagel" << "message2" << FoamDataType << endl;

e Useful diagnosatic tool:

— used to monitor a field, cell value, energies, etc. in a simulation

)

— statements can be inserted to find the line where a code ‘blows up

e Useful post-processing tool: this will be demonstrated later
Reading and writing case data

e Most case data is read/written using the I0object class
e An IOobject is typically constructed from

Name used for the name of the file

Instance used for the name of the directory

Object Registry that the object is registered with

Read Option controls reading from file; defaults to NO_READ
Write Option controls writing to file; defaults to NO_WRITE

e For the pressure field, the I0object is

1 I0object pheader
55 (

56 "p"; // Name of pressure field file

57 runTime.timeName(), // Time directory it is read from

58 mesh, // The mesh object registry

59 I0object: :MUST_READ // Read p in from file

60 i I0object: :NO_WRITE // Do not "automatically" write it out
61 3

e Further code creates an I0object for U
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Reading a field

=

2

NN
oo aw

-
© =

80
81

if (pheader.header0Ok() && Uheader.headerOk())
{

mesh.readUpdate () ;

Info<< " Reading p" << endl;
volScalarField p

pheader, // IOobject
mesh // fvMesh

header0Ok () function checks if p and U files exist
mesh.readUpdate() re-reads the mesh if modified
Constructs a volScalarField for p by reading from file, using

I0object instructs where to read/write the file

fvMesh the mesh that relates to the field, to ensure consistency

Further code creates a volVectorField for U

Access functions

e Objects like p contain a lot of stored data
e Data can be accessed by functions using syntax object.functionName ()

e For example, for p, we could call the following

.mesh() returns the mesh relating to the pressure field
.name () returns the name of the pressure field
.dimensions() returns the dimensions

.internalField() returns the internal field (cell values) only

.01dTime () returns the pressure field from the previous time step

' v W W T o

.size() returns size of the pressure field (no of cells)
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Finding functions that exist

Users want to know if functions exist that do what they need
Source code documented using Doxygen (http://www.doxygen.org)

Can be accessed online:

http://wwu.openfoam.com/docs/cpp

Can be built from sources using doxygen (may require root permission;
ensure OpenFOAM env variables are set)

>> cd $WM_PROJECT_DIR/doc/Doxygen
>> doxygen

From the top level, the Classes menu is particularly useful
Alphabetical List and Class Members are useful sub-menus
In Class description, List of all members is particularly useful

Inheritance and collaboration diagrams provide description of class hi-
erarchy

Creating a new field

84
85
86
87
88
89
920
91
92
93
94
95
926

97

if (p.dimensions() == dimensionSet(0, 2, -2, 0, 0))
{
volScalarField ptot
I0object

"ptot",
runTime.timeName (),

mesh,
IO0object::NO_READ

),
p + 0.5*magSqr (U)

péot.write();

e Code compares dimensions of pressure to those of kinematic pressure:

L2/T?

e Code evaluates differently depending on dimensions

— for kinematic pressure, it evaluates p + |U|?/2
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— for dynamic pressure, it evaluates p + p|U|?/2

e For kinematic pressure, constructs a volScalarField named ptot from
an I0object and p + 0.5*magSqr (U)

e write() function writes the ptot field to the current time dir.

Ending the utility

140
141
142
143
144
145
146
147
148

else

Info<< " No p or U" << endl;

}

Info<< endl;

}
return(0);

e Print a terminal Info message if p and U field does not exist in the
current time directory

e Ends with return(0) ;

Summary of key classes

#include createTime.H: creates Time database named runTime

#include createMesh.H: creates fvMesh named mesh

I0object class controls data read/write and storage on database

volScalarField, volVectorField classes create field objects, e.g. p, U

e dimensionSet class defines dimensional units
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5 Solver development

5.1 Modifying a solver

Solver source code

e Let us look at icoFoam

e Go to the user’s equivalent solver directory

>> cd $WM_PROJECT_USER_DIR/applications/solvers/incompressible
>> cp -r $FOAM_SOLVERS/incompressible/icoFoam .
>> cd icoFoam

e It contains the C++ files icoFoam.C and createFields.H
Info statements revisited

e Demonstrate Info<< statements as a post-processing tool

e Aim: in the parallelPlateSymm case, monitor U, in a cell adjacent to
centreline at x = 0.29

(0.29, 0, 0)

e Before making changes, edit Make/files to write compiled solver to
user’s account

icoFoam.C

1
3 EXE = $(FOAM_USER_APPBIN)/icoFoam
e Compile the solver with wmake

Writing new OpenFOAM code

¢ In icoFoam.C, add code at the end of the time step loop, (line 101)

e First we need to add our location; use the OpenFOAM vector class

101 vector location(0.29, 0, 0);
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Y Solver development 5.2 Dictionary 1,
; : strip out values for plotting with grep and cut
e Find the nearest cell to that location; use the label class e Strip out ve I g grep
5 : : - >> grep centreline log | cut -d" " -f4,7
e Search the code for an appropriate function " 0.050291_00833
g 0.0004 1.01321

>> find $FOAM_SRC -type f -name "*.C" -exec grep -iE "find.*cell" {} \; 0.0006 1.01875
celll = owner_.mesh() .findNearestCell(position) ;

e This command can be redirected to another file and the data plotted
e findNearestCell(...) can be applied to a mesh, taking location as

an argument; add to icoFoam.C: Basic classes in OpenFOAM

102 label celll = mesh.findNearestCell(location);

e There are a number of basic classes in OpenFOAM
e Note: When searching for a definition of a function, precede the function

name by ::, e.g. e ...derived from more fundamental C++ classes
>> find $FOAM_SRC -type f -exec grep -1 "::findNearestCell" {} \; > e OpenFOAM’s classes have a bit more functionality, so use them
Accessing field components C++ class OpenFOAM class and additional features
4 int/long label  Automatic switching
e Cell values are obtained from fields using the syntax for an element of boo} =ik f}cgepts t'rue/fals.e, on/Off" ’yes/no
an array U[. . .] i . string word Strings with no whitespace, ‘/’, etc.
e float/double scalar Depends on $WM_PRECISION_OPTION
e The vector class has x(), y() and z() functions to access scalar com- C — vector 3D vector with algebra
ponents _ tensor 3x3 tensor with algebra
e Add the Info statement 2 e Note: C++ has a vector class, similar to an array
103 Info<< "centreline: t = " << runTime.timeName () .
104 << " Ux = " << Ulcelll].x() << endl; 5.2 Dictionary I/O
e endl = end line The createFields.H file

e nl = insert new line

The icoFoam.C file begins with #include files discussed previousy un-

til. ..
Test the Info statement '

43 # include "createFields.H"

e Recompile the solver

i, e Creation of solver fields usually contained within a createFields.H file

e Run the modified icoF the 1lelPlateSymm case redirecting . . . ;
AU bbe modified. 105ReAd on. the pazadle ¥ r e Creates an I0dictionary from an IOobject that reads in the case file
output to a log file

constant/transportProperties:
e Output produces lines like

centreline: t = 0.0002 Ux = 1.00833

T — o OpenVFOAM-1.7.1 (©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenVFOAM-1.7.1
(OF4 S- pentUr A v1.7.1 rev 7. 3/5/20




12 Solver development . 5.3 Fields and field algebra 73

- 5.3 Fields and field algebra

I0dictionary transportProperties

Field construction

I0object
(
7 "transportProperties", // name of the file
8 runTime.constant (), // the case "constant" directory e Pressure created by
9 mesh, // the mesh object registry
10 I0object: :MUST_READ, // read in from file " volScalarField p
11 I0object::NO_WRITE // do not write out to file o
12 ) 23 I0object
i ¥ 24 (
25 "P"’
e Creates kinematic viscosity nu of type dimensionedScalar by a lookup b runline.timeNane (),
of keyword nu from transportProperties 28 I0object: :MUST_READ, _ _ ,
29 IO0object::AUTO_WRITE // write out to file automatically
15 dimensionedScalar nu :ll) r)nésh
16 ( o ;

i transportProperties.lookup("nu")

e AUTO_WRITE applied to fields we write out to time directories according
to controlDict settings

Dictionary lookup

e All fields written out by write() function called on the database in
The user can therefore read in keyword entries by < icoFoam.C

1. Creating an I0dictionary o EodlvewritEll;

2. Looking up entries with the .lookup("keyword") function e 3 common ways to construct a field, with different file read /write options:

Read Write Constructor
v v/ volScalarField(IOobject, fvMesh)
X v volScalarField(IOobject, volScalarField)
X X volScalarField(volScalarField)

lookup ("keyword") returns an Istream

Most objects can be constructed from Istream, e.g.

class object(dict.lookup("keyword")); // Construct from Istream

e ...because type of object can be established from syntax, e.g. More about Aelds

— string ("hello world")

e Velocity flux instantiated as i
— (hello) elocity flux instantiated as surfaceScalarField

— Switch (on/yes/true) 50 #include "createPhi.H"

— dimensionedScalar $FOAM_SRC/finiteVolume/1nInclude/createPhi . H:

e scalar (1) and label (1) are exceptions a0 surfaceScalarField phi

(
. / . ) 42 I0object
e = special readLabel /readScalar functions create a scalar/label 3

43 (
44 "phi" s
scalar a(readScalar(dictionary.lookup("a"))); 45 runTime.timeName (),
label i(readLabel (dictionary.lookup("i"))); 46 mesh,
OpenV/FOAM-1.7.1 ©2008-2011 OpenCFD Ltd V171 rev 7. 3/5/2011 OpenVFOAM-1.7.1
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74 Solver development
47 I0object::READ_IF_PRESENT, // Read if file exists
48 IO0object::AUTO_WRITE
49 )5
50 linearInterpolate(U) & mesh.Sf() // ...otherwise evaluate
51 K

e What does “linearInterpolate(U) & mesh.Sf()” do?
— What is a volScalarField, surfaceScalarField, etc.?
— What is the “&” symbol?
— What about “mesh.Sf()"?

Meshes

Description Symbol  Function

Cell volumes Vv vQ)

Old time step cell volumes Ve voO

Old-old time cell volumes Voo Voo Q)

Face area vectors St Sf()

Face area magnitudes [S¢ magSTt ()

Cell centres C cO

Face centres C; CfQO

Face motion fluxes ) phi Q) .
e There is a hierarchy of mesh classes including geometricMesh, polyMesh <

e fvMesh: includes extra functionality for finite volume discretisation

e In particular, it stores data relating to access functions above

OpenVFOAM-1.7.1
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volScalarField, volVectorField, etc.

The

volScalarField is not a class; it is a typedef (alias)
typedef: an alias for a class to make the code more easily readable

Used particularly with template classes, e.g. for a“scalar field” Field<scalar>
reads as “field scalar”

= $FOAM_SRC/OpenF0AM/1nInclude/scalarField.H

49 typedef Field<scalar> scalarField;

To find a typedef: use multiple grep commands:

>> find $FOAM_SRC -type 1 | xargs grep -1 typedef | xargs grep -1
"volScalarField;"
$WM_PROJECT_DIR/src/finiteVolume/IlnInclude/volFieldsFwd.H

— Note the terminating semicolon (;)

The actual class is GeometricField
$FOAM_SRC/finiteVolume/lnInclude/volFieldsFwd.H:

54 typedef GeometricField<scalar, fvPatchField, volMesh> volScalarField;

GeometricField class

GeometricField<Type, PatchField, GeoMesh>> is templated on 3 ar-
guments

GeoMesh and PatchField arguments specify where values are defined

Type specifies what the values are, e.g. scalar, vector, etc.

volMesh/fvPatchField
e.g. pand U

surfaceMesh/fvsPatchField
e.g. phi

©2008-2011 OpenCFD Ltd
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Tensor fields

e Fields can be of the following <Type>

Rank Name <Type> Example nCmpts
0 Scalar scalar P 1
1 Vector vector U 3
2 Tensor (general)  tensor VU 9
2 Symmetric tensor symmetricTensor VU + VUT 6
2 Spherical tensor sphericalTensor pl 1

e Special tensors are constructed by default, e.g. Identity tensor I:
$FOAM_SRC/0penFO0AM/1nInclude/sphericalTensor . H:

51 static const sphericalTensor I(1);

Field algebra

e Algebra can be performed on fields

Operator Ranks Expression OpenFOAM
Inner product =1 asb a&b
Double inner product 2 athb a&& b
Cross product 1 axb a“~b
Outer product abt a*b
Square a’ = aa sqr(a)
Magnitude squared laj2=ata magSqr (a)
Magnitude la| = vata mag (a)
Transpose 2 a’ a.TO
Trace 2 tra=1I2a tr(a)
Symumetric 2 symma = (a+aT)/2 symm(a)
Skew 2 skewa = (a —aT)/2 skew(a)
Deviatoric 2 deva =a — (tra)I/3 dev(a)
Deviatoric (II) 2 devija =a — 2(tra)I/3 dev2(a)
ta®b

e There are more operators, like transcendental scalar functions, sin, exp
ete.

©2008-2011 OpenCFD Ltd V1.7.1 rev 7. 3/5/2011 OpenVFOAM-1.7.1
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e

Field interpolation
e [nterpolation: transforms a vol<Type>Field to a surface<Type>Field
e fvc::interpolate(Q): generic interpolation function
— scheme selected in fvSchemes case file

e linearInterpolate: hard coded linear interpolation, e.g. for Q

Ing e dpn|
Qr = wiQp + (1 — wr)Qn, Wf = e
nged|
The flux phi
e Let’s return to the expression for phi
volVectorField fvMesh
= ~ =

linearInterpolate( U ) & mesh . Sf ()

~ N—
surfaceVectorField * surfaceVectorField

e Returns the surfaceScalarField phi from inner product of two sur-
faceVectorFields

® phi: volumetric flux through the cell faces

e OpenFOAM will not permit algebra between a vol<Type>Field and a
surface<Type>Field
©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenVFOAM-1.7.1
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5.4 Implementing equations

Back to the solver...

e Next...
50 while (runTime.loop())
51 {
52 Info<< "Time = " << runTime.timeName() << nl << endl;
53
54 # include "readPISOControls.H"
55 # include "CourantNo.H"
56
57 fvVectorMatrix UEqn
58 (
59 fvm: :ddt (U)
60 + fvm::div(phi, U)
61 - fvm::laplacian(nu, U)
62 Yy
63
64 solve(UEqn == -fvc::grad(p));

e [mportant. .. creating and solving equations

e We need to understand what fvVectorMatrix, fvm: :, solve, etc. mean
Discretisation

e Discretisation = approximation of a continuous problem into discrete

quantities
Continuous Discrete OpenFOAM class
Time Time steps (intervals) Time
Space (geometry) Mesh of cells fvMesh
Fields Cell values vol<Type>Field
Differential eqns.  Algebraic eqns. fv<Type>Matrix

e fv<Type>Matrix describes an algabraic equation for a vol<Type>Field,
e.g. Q, storing:
— [M] = matrix coefficients

— B = source — also a vol<Type>Field

/
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My My ... Mn Q. B,
]\[21 ]\[22 cee A[QN Q2 B_g
Myy My ... Mpyn QN By

[M] Q = B

Terms in equations/expressions

e Eqns contain derivatives such as Vo, V, V2, Vx

e OpenFOAM has functions for derivatives, e.g. div, grad, laplacian,
curl

e To calculate derivatives with current values, prefix with fvc::
— e.g.fvc::grad(p) calculates the pressure gradient Vp
— fvc:: returns a field

e To discretise a term into matrix equation you wish to solve, prefix with
fvm::

— e.g. to solve V«I'Vp = 0, use fvm: :laplacian(Gamma, p)
— fvm:: returns an fvMatrix

Solution method and equations

e OpenFOAM uses the finite volume method for discretisation
e Co-located framework: solution fields defined at cell centres

e Scgregated, decoupled: solves scalar matrix equations in an iterative
sequence

® = There are only 4 terms that can form matrix coefficients, i.e. can “be”
fvm::
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Description Expression  Function
Time derivative  0pQ/0t fvm: :ddt(rho, Q)
Convection V.«(pUQ) fvm::div(phi, Q)
Laplacian V.I'VQ fvm: :laplacian(Gamma, Q)
Source pPQ fvm: :Sp(rho, Q)

e Equivalent functions exist for 9Q/0t and V2Q (without p, I')

e Convective derivative: fvm::div function with surfaceScalarField
flux (phi) as the 1st argument

Common source terms/derivatives

e Equation (explicit) source terms can be calculated using the following
functions

Description Expression Function

Divergence V+Q fvc::div(Q)
Gradient vQ fvc::grad(Q)
Curl VxQ fvc::curl(Q)
Source Q Q

Back to the solver...

e Solver implements the momentum equation

%Jrv-(UU)—V-I/VU: ~Vp

e All terms in U can be treated implicitly (fvm::)

e fvVectorMatrix created for all terms except Vp (we will find out why
later)

56 fvVectorMatrix UEqn
57 (

58 fvm: :ddt (U)

59 + fvm::div(phi, U)

60 - fvm::laplacian(nu, U)
G1 );

e The “right hand side” (fvc::grad(p)) introduced with the == operator

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011 OpenvFOAMlJ-l
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.t

e solve function solves the fvVectorMatrix equation

63 solve(UEqn == -fvc::grad(p));

e Next...the PISO loop

5.5 The PISO algorithm

Mass conservation in incompressible flows

e Mass conservation equation

ap
— +V.(pU) =0
g TV V)

e Incompressible = p = const

V.U=0

e 3 components of velocity U, Uy, U,; only 1 equation

A constraint, not a solvable equation
e Incompressible flow is often dominated by this constraint
e (Q: How can we solve the system ensuring this constraint is satisfied?

e A: Use the pressure-implicit split-operator (PISO) algorithm
The “trick” in PISO

e Manipulation of [U Eqn]

2]
-
t o] o
A H(U)

e A and H are evaluated by functions UEqn.A() and UEqn.H()
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— A contains 1 value per cell = a volScalarField

— H is calculated using latest values of U = a volVectorField

e Explicit momentum equation

(ZTEI+V-(UU)—V-UVU:—V[)
[UEqn] = - Vp

AU =-Vp+H

Equations in PISO

e From the expression for momentum

AU=H-Vp
e ...a momentum corrector equation can be written
H 1
U=—=-=Vp
A At

e Applying mass continuity (VU = 0), a pressure corrector equation is
derived

1 H
Ve=Vp=V.|—
e A flux corrector equation can be written

¢ = St Uy = Ste [(H/A), — (1/A); (Vp)]
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Dt

PISO algorithm

5 ; New p, U, ¢
Start time step <=

Momentum matrix [U Eqn]

Solve momentum [UEqn] = —Vp

Evaluate H(U), A-+—

1 H
Pressure corrector Ve—=Vp =V <—>_ D

A A 1
|
I
New p :
t
Momentum corrector H 1 !
and flux corrector © — A Zv]) ‘ Y
I 6 = St [(H/A), — (1/4), (Vp)]

End time step

PISO algorithm and OpenFOAM code

Start time step

56 fvVectorMatrix UEqQn
57
o 58 fvm: :ddt (U)
[U Eqn] 59 + fvm::div(phi, U)
60 - fvm::laplacian(nu, U)
61 );
[U Equ] = -Vp 63  solve(UEqn == -fvc::grad(p));
69  volScalarField rUA = 1.0/UEqn.AQ);
Evaluate H(U), A 70 U = rUA*UEqn.HQ);
Y 72 phi = (fvc::interpolate(U) & mesh.Sf())

1 H
V. _/va =V (—> 79 fvScalarMatrix pEqn
! A 80 (
81 fvm::laplacian(rUA, p) == fvc::div(phi)

New p LR
| / s5  pEqn.solve();
H 1
U=—__ ZVP Lsm U -= rUAxfvc: :grad(p);l

A
Vo s (B/A) — (1/A) (Vo) [ = o - pmia0y]
End time step
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D.

84 Solver development

SIMPLE: Semi-implicit methods pressure-linked equations
New p, U, ¢

Final comments on the solver

Start time step -e—

e U field temporarily stores H/A, rather than creating a new field 5. 0,

Momentum matrix [U Eqn] =

e Similarly, phi field temporarily stores the flux of H/A
‘ Under-relax [U Eqn]

e Recovering U with the momentum corrector is simple (-= rUA*fvc: :grad(p))
X ) X ) Solve momentum [U Eqn] = —Vp
e A flux() function returns the flux field from the matrix

e Loop over the pressure, momentum and flux correctors Evaluate H(U), A

67 for (int corr=0; corr<nCorr; corr++)

1 H
Pressure corrector Ve ZVP =V. (74->
e Correct fluxes to conserve globally in badly-posed cases
75 adjustPhi(phi, U, p); Under-relax p

e Loop over the pressure to correct non-orthogonality

Momentum corrector U - H 1 - L
and flux corrector A APt/ \'
i 6 = S+ [(H/A); - (1/4); (Vp)]

End time step

77 for (int nonOrth=0; nonOrth<=nNonOrthCorr; nonOrth++)

e Set value in pRefCell to pRefValue for cases with no fixedValue p
boundary

T p—— Advantages and disadvantages of PISO and SIMPLE

Algorithm  PISO SIMPLE

Efficiency  Fast: [U Eqn| created once  Slower: Under-relaxation

Stability Can be unstable for Co > 1  Stable for Co > 1

Accuracy  Potential 0/0t error —

e Advantages/disadvantages relate to algorithm loop structure, particu-
larly construction of the momentum matrix [U Eqn|

SIMPLE solvers in OpenFOAM

e SIMPLE algorithm generally used in steady-state solvers

® simpleFoam is the most basic solver with the SIMPLE algorithm; in-
cludes turbulence modelling

e Under-relaxation is performed using the relax() function
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5.6 Modifying a solver

86 Solver development

e Add (Vp), to [UEqn] so that PISO still constructs a p equation from

— fvMatrix can be under-relaxed by increasing the diagonal and
° [UEqn] = —Vp

adding an equivalent contribution to source based on existing val-

ues e Let’s try adding (Vp), = —3 by the following modification:
9 UEqnQ) .relax();
ici . : 57 fvVectorMatrix UEqn
— A field can be explicitly under-relaxed using values from the previ- 58 ( a
50 fvm: :ddt

60 + fvm::div(phi, U)

61 - fvm::laplacian(nu, U)
62 - 3.0

63 ¥

ous iteration; requires the previous iteration to be stored
57 p.storePreviter();

38 p.relax();

e Try compiling this. It does not compile. Why not? There are two
reasons. Think about it. ..

5.6 Modifying a solver

Exercise: creating a specialised parallel plate flow solver
Parallel plate flow solver: modifications (2)

e Task: to create a new parallelPlateFoam solver by modifying icoFoam
e Mistake 1: Equations and field algebra does dimension checking — you

e ...by adding (Vp), as a body force cannot add/subtract tensors without dimensions

e = flow drives itself — no need to apply (Vp), through boundary con-
ditions

e You can do tensor operations between fields and single dimensioned
tensors: the dimensioned<Type> class

e Create the parallelPlateFoam source directory by copying icoFoam e Mistake 2: Momentum is a vector equation; (Vp), needs to be a vector

@ 9t o ale
>> cd $WM_PROJECT_USER_DIR/applications/solvers/incompressible but “-3" is a scalar
>> cp -r icoFoam parallelPlateFoam
>> cd parallelPlateFoam
>> wclean
>> mv icoFoam.C parallelPlateFoam.C

e = (Vp), needs to be a dimensionedVector

e The dimensioned<Type>> class stores 3 items of data

e Edit the Make/files file: word used for internal naming of other fields

parallelPlateFoam.C dimensionSet the dimensions

EXE = $(FOAM_USER_APPBIN)/parallelPlateFoam Type the type of value, scalar, vector, tensor, . ..

Compile the solver
¢ omplie 3he solver Parallel plate flow solver: modifications (3)

Parallel plate flow solver: modifications , ) : :
e Let’s create a dimensionedVector in createFields.H:

e The (Vp), terms needs to be added to the momentum equation: 57 dimensionedVector gradPx
58
ouU e e g [ ok g
) 60 p.-dimensions () /dimLength,
o1 +V+(UU) -V«vVU = —(Vp), — Vp 61 vector (-3, 0, 0)
62 );

©2008-2011 OpenCF T s 7 i
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e Now add gradPx to UEqn in parallelPlateFoam.C Parallel plate flow solver: test case (2)

56 fvVectorMatrix UEqn Run blockMesh

57 ( *

58 fvm: :ddt (U) .

59 + fvm::div(phi, U) e Edit the 0/p and 0/U files; in boundaryField sub-dictionary, add a new
60 - fvm::laplacian(nu, U) '

&1 + gradPx patch entry:

62 ) ']

leftAndRight { type cyclic; }

e Compile the solver )
e Change endTime to 5 in the controlDict file

Parallel plate flow solver: test case e Run parallelPlateFoam

e Test case: create a parallelPlateCyclic case by cloning the parallel- e Run sample and gnuplot to view results

PlateSymm case
Parallel plate flow solver: improvement
>> run

>> cp -r parallelPlateSymm parallelPlateCyclic

>> cd parallelPlateCyclic e Let’s make (Vp), runtime-selectable instead of hard-coded

e Apply cyclic (periodic) boundary on left and right, one cell in z- < e In createFields.H:

direction
— Initialise gradPx to be zero: replace vector(-3.0, 0.0, 0.0) by

cyclic vector(0.0, 0.0, 0.0)

‘ — Read a scalar called parallelPlateGradPx from transportProp-
3 \2 P p P

v owall : \ erties

b = T » 6 64 scalar parallelPlateGradPx

I 1 55 (
g K \ 66 readScalar (transportProperties.lookup("parallelPlateGradPx"))

1770~ ~ 67 )3

4 o] — Set the x component of gradPx; add minus sign, so user supplies a

positive value

; . : 6o gradPx.value().x() = -parallelPlateGradPx;
e Edit the constant/polyMesh/blockMeshDict file

. . L. e Compile
— blocks: make 1 cell in z-direction

hex (01 234567) (1201) simpleGrading (1 1 1) e Inthe constant/transportProperties file of the parallelPlateCycl-

: ic case, ¢ he ent
— patches: replace the inlet and outlet patches by: case, add the entry

cyclic leftAndRight 69 parallelPlateGradPx 303
(
(047 3)

(265 1) e Re-run parallelPlateFoam
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Summary of further key classes

e I0dictionary class stores data file (dictionaries) on database, from

which keywords can be looked up

e scalar, vector, tensor include associated algebra

see Scalar.H, TensorI.H

e GeometricField: actual class for p, U, phi, etc.

e fvMatrix class for finite volume matrix, e.g. UEqn

6 Boundary conditions (BCs)

6.1 Introduction to BCs
Overview of boundary condition (BC) modelling
e [nformation must be supplied at all boundaries to solve an equation for
some dependent variable, Q
e Data for Q can be provided, typically as

— A fixedValue (or Dirichlet) BC specifies values Q

— A fixedGradient (or Neumann) BC specified gradients normal to
the boundary (n«VQ), = (VaQ)s

e A geometric constraint can be applied, e.g. symmetryPlane, cyclic

e Complex BCs vary Qy or (V,Q), depending on other fields, e.g.

p=po—|U]*/2

e More complex BCs change type according to other local fields, e.g. for
an outlet

p=pp for Mach <1
Vaup =0 for Mach > 1

BC classes

e fvPatch: class describing geometry of a boundary patch, i.e. the set of
faces

e fvPatchField<Type>: base class for a field of Type, i.e. set of values,
on an fvPatch

e Hicrarchy of classes exists for the application of BCs

(©2008-2011 OpenCFD Ltd
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Boundary conditions (BCs)

fvPatchField<Type> db()

patch()
updated()
updateCoeffs()

Y y

constraint

A

valueBoundaryCoeffs()
gradientInternalCoeffs()

basic E valueInternalCoeffs()
gradientBoundaryCoeffs()

derived updateCoeffs()

e basic: data BC base classes, e.g. fixedValue and fixedGradient
e counstraint: geometric constraint BC classes, e.g. symmetryPlane

e derived: higher-level classes of complex BCs

BC classes (2)

basic and constraint BCs are generally template classes

For example, fixedValue can be for a field of scalars, vectors, tensors,

These low-level BCs hook into matrix discretisation

No need to modify these classes

derived BCs are more important to users because. . .
Users may wish to interpret functionality in existing BCs

Users may wish to add a new derived BC

Where is the source code for BCs?

1. General BCs in $FOAM_SRC/finiteVolume/fields/fvPatchFields

>> 1s -1 $FOAM_SRC/finiteVolume/fields/fvPatchFields
basic

constraint

derived

fvPatchField
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6.2

2. Model-specific BCs in derivedFvPatchFields directories

>> find $FOAM_SRC -name derivedFvPatchFields

3. Solver-specific BCs in solvers directory

>> find $FOAM_SOLVERS -name "*FvPatchx*"

Understanding existing BCs

Understanding existing BCs

To understand what an existing BC does:

1.

2.

Locate the class files
In the .H file, find the class it is derived from, e.g. fixedValue
In the .H file, locate the private data that the BC uses

In the .C file, examine the updateCoeffs() function — it describes the
BC

Derived fixedValue example: overview

In an earlier example we do a “back of an envelope” calculation for
turbulent kinetic energy k at the inlet

isentropic turbulence U, * = U} ? = U ? = 0.05 of the inlet velocity

Instead, the turbulentIntensityKineticEnergyInlet BC calculates
this

Specifies kinetic energy k at an inlet by the intensity — a fraction of
U]

Go to the source code

>> src

>> cd finiteVolume/fields/fvPatchFields
>> cd derived/turbulentIntensityKineticEnergyInlet
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Boundary conditions (BCs)

Derived fixedValue example: base class

e We first ask: which class is this BC derived from?

e Look after public the class declaration code in the .H file, e.g.

60 class turbulentIntensityKineticEnergyInletFvPatchScalarField
61 :

62 public fixedValueFvPatchScalarField

63 . wos

e = it is derived from fixedValue

e = it is specifically for a scalar field, i.e. k

Derived fixedValue example: input data

e Look in turbulentIntensityKineticEnergyInlet.H

e Private data for the BC is intensity

66 //- Turbulent intensity as fraction of mean velocity
67 scalar intensity_;

e The TypeName used for runtime selection is also there
72 TypeName ("turbulentIntensityKineticEnergyInlet");

e To use the BC, the user would specify on relevant patches in a case 0/k
file

inlet
type turbulentIntensityKineticEnergylInlet;
intensity 0.05;
value uniform 1; // typically needed by paraview
¥

e Note: it is safer to initialise BCs with a value, even though it is over-
ridden, to stop ParaView complaining

©2008-2011 OpenCFD Ltd
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Derived fixedValue example: updateCoeffs()

112
113
114

114
115
116
117

void Foam::turbulentIntensityKineticEnergyInletFvPatchScalarField::
updateCoeffs()
{

Checks the updated switch is off, otherwise returns the function
if (updated())
{

return;

Gets a reference to the field data for the corresponding patch in the
velocity volVectorField (U) stored on the database

const fvPatchField<vector>& Up =
patch() .lookupPatchField<volVectorField, vector>("U");

Evaluates the fixed value boundary from the intensity_ and U

Note! A fixedValue boundary value requires a double equal ‘==" to
reset it
operator==(1.5%sqr(intensity_)*magSqr (Up)) ;
Sets the updated switch to on
fixedValueFvPatchField<scalar>::updateCoeffs();

Derived fixedGradient example

113
114
115
116
117

133

©2008-2011 OpenCFD Ltd

buoyantPressure BC

Derived from fixedGradient but similar structure to the fixedValue
example

Difference in the updateCoeffs() function: instead of updating the
value through operator==, the gradient is updated through a non-const
access function — gradient ()

Looks up density patch field rho and gravitational acceleration g from
the database

For static pressure, evaluates Vu,p = —p(neV[gex|) = p(neg)

const uniformDimensionedVectorField& g =
db() .lookupObject<uniformDimensionedVectorField>("g");

const fvPatchField<scalar>%& rho =
patch().lookupPatchField<volScalarField, scalar>(rhoName_);

gradient() = rhox(g.value() & patch().nf());

v1.7.1 rev 7. 3/5/2011
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Derived mixed example

e mixed is a blend of fixedValue and fixedGradient

e [t stores: a valueFraction a; a refValue Qp and refGradient (V,Q),
1 for fixedValue Q = Q,
0 for fixedGradient V,Q = (V,Q),

e inletOutlet BC — a template mixed condition, switches between:

— fixedValue if velocity flux is inward (an inlet)

— zeroGradient if velocity flux is outward (an outlet)
e The inletOutlet condition

— Reads in inletValue assigns it to refValue
— Sets refGradient to zero

— Sets valueFraction according to the direction of the velocity flux

135 this->valueFraction() = 1.0 - pos(phip);

6.3 Creating a customised BC

Creating a customised BC

e We want to create an inlet BC for velocity with the turbulent profile
described previously

U, ~ ZQ (1 = %) .

e Let’s call the new BC turbulentProfileInletVelocity
e For speed: we will “hack” something together here
e Similar to the existing flowRateInletVelocity BC

fl ate
Ue=Q = _low rate
patch area
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Creating the source code directory and files

e We will compile our new BC into a new turbulentProfilelnlet library
e Create a new directory structure in the $FOAM_RUN directory

>> run
>> mkdir -p turbulentProfilelnlet/Make
>> cd turbulentProfilelnlet

e Clopy the flowRateInletVelocity class code and rename the files

>> DERIVED=$FOAM_SRC/finiteVolume/fields/fvPatchFields/derived
>> cp $DERIVED/flowRateInletVelocity/* .
>> rename ’s/flowRateInlet/turbulentProfileInlet/g’ *.*

e Do a word replacement of flowRateInlet by turbulentProfileInlet

>> sed -i ’s/flowRateInlet/turbulentProfileInlet/g’ *.*

e We have a new turbulentProfileInletVelocity class that does
the same as flowRateInletVelocity

Compiling the library

e Create the necessary files in the Make directory
e Our class is derived from bases classes in the finiteVolume library

e Copy an options file from elsewhere; one exists that is exactly what we
need

>> cp $FO0AM_SRC/turbulenceModels/LES/LESfilters/Make/options Make/

e Make/options — copied (above):
1 EXE_INC = -I$(LIB_SRC)/finiteVolume/lnInclude

2
3 LIB_LIBS = -1finiteVolume

® Make/files — create ourselves:
1 turbulentProfileInletVelocityFvPatchVectorField.C
2
3 LIB = $(FOAM_USER_LIBBIN)/libturbulentProfileInlet
e Compile the library

>> wmake libso
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Boundary conditions (BCs)

The existing BC

Open turbulentProfileInletVelocityFvPatchVectorField.C in an
editor

Examine the updateCoeffs function
Existing code calculates average flow speed avgU
121 scalar avgl = -flowRate_/gSum(patch().magSf());
... then it stores the unit normal vector patch() .nf ()
123 vectorField n = patch().nf();
...then applies the average speed in that direction
131 operator==(n*avgl) ;
patch() .nf () points out of domain so negative avgU ensures inflow

Geometric data accessed via the patch() function which returns the
fvPatch

Modifying the BC

Our flow speed varies across the patch, not a single average value
= it must be a scalarField, not a scalar

Replace the name avgU with magU

Replace the magU (avgU) constructor (line 121) with

121 scalarField y = patch().Cf().component(1);
122 scalar R = 0.01;
123  scalarField magU = -5.0/4.0*flowRate_*pow((1.0 - y/R), 1.0/7.0);

Note: we are now using flowRate_ as () “flow rate per unit area”

Recompile the library

>> wmake libso

Creating a customised BC 99

Testing the new BC

Go back to the poiseuilleHighRe case

We can use our new library by linking it to the solver dynamically at
runtime

...by adding the new library to the libs list in system/controlDict
with

libs ("libturbulentProfileInlet.so");

Change the BC for the inlet patch in 0/U:

inlet
type turbulentProfileInletVelocity;
value uniform (1 0 0);

flowRate 1.0;

Run pisoFoam

Solution: at the inlet, velocity profile is similar to the developed flow
downstream

(©2008-2011 OpenCFD Ltd v1.7.1 rev 7. 3/5/2011
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100 Finite volume discretisation

A Finite volume discretisation

The finite volume method

The finite volume (FV) method is one form of equation discretisation. In
general:

e Discrete quantities Q; are primarily stored at the centroids (C) of each
cell 4

e Terms in a PDE are discretised by integrating over the cell volume V
e Integrals over V of spatial derivatives are converted to integrals over the

cell surface S using Gauss’s Theorem

VxQdV = /dS*Q (x= o, %, @)
JS

1%

e Other integrals over V are approximated assuming Q is uniform across
the cell

/ QdV = QeVp
|74

e Integrals over S are approximated by summations over cell faces (f) of
products of the normal area vector Sy and Qy, interpolated from cell
centres to faces

/s:ds*Q:Zsf*Qf
: -

Laplacian discretisation

e laplacian(Gamma, Q) = V«(I'VQ)

Vv

e Surface normal gradient snGrad()

nee (VQ)p=Cad+ (VQ)i+ ke« (VQ),

orthogonal non—orthogonal

=Ca(Qn — Qp) + k- (VQ);

OpenVFOAM-1.7.1
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= | W (I'vQ)dv = / dS.(I'VQ) ~ Z IS« (VQ)r = ZFHSHHP (VQ);
s T T

7 101

I)

Ca=1/In;-d| (=1/Az)

\ k:nf—CAd
1

Laplacian discretisation (2)

e fym::laplacian(Gamma, Q)

Ve(IVQ) = ) (Ii[S|Ca (Qn — Qp) + I¥[Silk+ (VQ),)
f

= e Contribution to matrix and source from face spanning cells 1 and 2,
(positive k for owner cell P= 1):

' 1:|f51‘\(7'_\ +TeS¢lCa ... My Q: e[Stk (VQ);
' FI¢[S¢|Ca e|S¢|Ca ... May Q- FL¢[Selk (VQ);
= M Mpyo ... Myn Qn By

Gradient and divergence discretisation

’ e fvc::div(Q) = V«Q
" :/V.de:/ds.qzzsf.Qr
Jv Js :

® Qs usually evaluated by linear interpolation
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Must be fvc:: - decreases rank by one (e.g. Q = vector, V« Q = scalar)

fve::grad(Q) = VQ
= / vQ dV:/dSQ%ZSfo
JV S f

Q¢ usually evaluated by linear interpolation

Must be fvc:: - increases rank by one (e.g. Q = vector, V«Q = 2nd
rank tensor)

e fvc::laplacian(Q) # fvc::div(fvc::grad(Q))
Convection - a special case of divergence
e div(phi, Q) = V.«(UQ)

= [ VewQ) v~ [ as.UQ)~ 38 U@ = Y i
|4 JS T P

e Typically implicit in Q: fvm::div(phi, Q), where
phi = (fvc::interpolate(U) & mesh.Sf())

e Interpolation of Q — Qg is critical for stability

— upwind: bounded, lst-order accurate

o {Q foror=0
o Qn for ¢y <0

— linear: unbounded, 2nd-order accurate

— Other schemes, e.g. SFCD, limitedLinear, vanLeer, etc., eftec-
tively blend between upwind and linear
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Time derivative discretisation

e ddt(rho, Q)

()(/)Q) - / ()(/)Q) dV =~ /’]’Q]"' — /;']',(‘)"I’J’u
ot ], "ot At

e Contribution to matrix and source from current time (no superscript)
and old time (o superscript) at P= 1:

/)I*"/'A/ A'IJN Ql /)’l)'(!l[:"”/-l,
: AI?N Q2 B :
My Mpys ... MnnN QN By

e fvm::ddt(rho, Q) The usual choice — time derivatives almost always
implicit

e Euler scheme shown above, first order in time

e Other second-order schemes available including backward differencing
and CrankNicholson
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104 The USB memory stick

B The USB memory stick
B.1 Booting the USB OpenFOAM /Linux memory stick

e The stick must be booted from the machine BIOS (i.e. when the machine
is switched on).

e On newer computers the USB device can be detected as a hard drive
(USB-HDDO).

— If your machine in one of these, you need to press a specific key
— typically one of either F2, F10, F11 or ESC — immediately after
powering on the machine.
— Some machines do not respond to a single (even long) press of the
key, but repeated pressing works effectively.
— Once in the “Boot Menu”, select USB DISK (USB DISK 2.0) with
up/down arrows and then hit enter to select and resume startup.

e On computers that are a bit older, or uses a simplified BIOS, you may
not have a Boot Menu option. In this case you will need to make the
system detect and boot your USB device by changing the settings in the
BIOS.

— Again, you need to enter the BIOS settings by pressing a specific
function key.

o If your BIOS lists the USB memory stick as a hard drive, you should
select it as the 1st boot device.

e The preferred choice of boot option is USB-HDD; USB-ZIP might work,
but USB-FDD is not supported.

e [t is recommended to remove other USB boot options from the boot
priority list, e.g. if booting with USB-HDD, remove USB-ZIP.

* Be careful to note that on some BIOSes you effectively need to make 2
selections:

— Move hard drive to the top of the boot priority list;

— Move USB to the top of the hard drive priority list.

Once booting, the display briefly reads SYSLINUX loading. . .

OpenVFOAM.1.7.1
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A menu of languages appears from which the user can select a preference.

If the user does not select English, they maybe asked later whether they
want certain standard directory names to be translated; select No.

The kernel loads; be patient, it can take some time.
e Next. Ubuntu Linux loads; again be patient.

e If all is working a live Linux session is automatically started.

B.2 Shutting down the memory stick
e Shut down by pressing the off bottom at the top right of the terminal
screen.
e When asked to remove the disc... and press ENTER to continue,

simply press enter.

e Remove the USB stick once the machine is switched off.

B.3 General use

e DO NOT REMOVE THE MEMORY STICK WHILE IN USE, ESPE-
CIALLY IF IT IS FLASHING: this is a likely way to corrupt the file
system on the stick, which is very difficult to restore.

e Problem at login: After Ubuntu is loaded, it can occasionally happen
that the live session fails to start, giving a message saying that it does
not have write permission for the . ICEauthority file. If this occurs, do
the following:

|

login.

In the login screen, type user ubuntu, leaving password blank.

A small terminal window appears in the Failsafe login.

|

— In the terminal type: rm -f .ICEauthorityx (hit enter).
— Now type: exit to return to the login screen

— In the menu at the bottom left of the screen select Options->GNOME
login.
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The USB memory stick

In the login screen, type user ubuntu, leaving password blank.

— You will now be logged into the live session.
O

e Problem at boot (1): If the system hangs towards the end of the boot
process, it is often due to a problem with the X-server starting the

graphics. If this occurs, reboot the machine and, at the point where the
user selects the language, hit the F6 function key. This brings up a menu
of additional boot options. The user should select nomodeset, then hit
Esc to continue booting.

Problem at boot (2): If memory stick is not working, the Master Boot
Record may need fixing

— Mount the USB drive on a Linux machine, check the device name,
here we will call it /dev/sdx.

— Then either try running install-mbr /dev/sdx (requires mbr pack-
age in ubuntu).

— Or try 1lilo -M /dev/sdx (requires lilo package).

Problem at boot (3): if a message appears like Boot Error immediately
that the BIOS attempts to boot from the disk then the problem may be
due to a setting in the BIOS. To fix this:

— Go into BIOS Boot Menu and search for USB Mass Storage Emulation
Type.

— If this is set to Default: <Auto>, change it to <A1l Fixed Disc>
or something similar.

Problem at boot (4): if the boot process appears to hang following a
message about £d0, it is likely because the system is searching for a
floppy drive that does not exist. To fix this, go into BIOS Boot Menu
and disable Floppy drive from the list of boot devices.
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